
Legrand CRM, Basic Training Workbook 
Legrand CRM Version 4.2x 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Applied Business Applications (ABA) 
Master Distributor of Legrand CRM in WA 

 
Shop 2,  424 Roberts Road 

SUBIACO WA 6008  

Phone 08 9381 6800 

Fax 08 9381 9044 

Email info@legrandcrm-wa.com.au 

Web www.legrandcrm-wa.com.au 
 

 



 

  

 Legrand CRM Users' Training Workbook  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Copyright �  2005 Legrand Software Pty Ltd. All rights reserved. 

Microsoft, Windows, Windows 2000, Windows XP, Word, Excel, Outlook and other names of Microsoft products 
referenced herein are trademarks or registered trademarks of Microsoft Corporation. 

All other brand and product names mentioned herein are used for identification purposes only, and are trademarks or 
registered trademarks of their respective holders. 

4.20.00, December 2005  
�



 

  

Contents 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

Contents 
Contents................................................................................................................................................ 3 
Legrand CRM edition and version in use........................................................................................... 6 

Start up screen............................................................................................................. 6 
Help About.................................................................................................................. 6 

r ight mouse button menu menus......................................................................................................... 8 
Company mode........................................................................................................... 8 
Contact Mode.............................................................................................................. 9 
Campaign Mode........................................................................................................ 10 

Exercise 1 – Overview of modes........................................................................................................ 12 
Companies mode....................................................................................................... 13 
Contacts mode........................................................................................................... 19 
Campaigns mode....................................................................................................... 25 
Opportunities mode................................................................................................... 29 
Calendar mode (as well as Tasks and Activity) .......................................................... 30 
MS Outlook mode..................................................................................................... 32 
Cust.Service mode..................................................................................................... 33 
Item Tracking module................................................................................................ 34 
Products mode........................................................................................................... 35 

Exercise 2 – Working in Companies mode ....................................................................................... 36 
Finding Companies.................................................................................................... 36 
Adding Companies.................................................................................................... 37 
Adding Contacts to a Company ................................................................................. 38 
Primary Contacts....................................................................................................... 38 
Deleting a Company .................................................................................................. 38 
Web URL field.......................................................................................................... 39 
Accounting tab .......................................................................................................... 40 
Documents tab........................................................................................................... 40 

Exercise 3 – Working in Contacts mode........................................................................................... 42 
Finding a Contact ...................................................................................................... 42 
Adding a new Contact ............................................................................................... 42 
Move a Contact to another Company......................................................................... 43 

Exercise 4 – Working with L ists........................................................................................................ 45 
Search for a list of Companies................................................................................... 45 
Search for a list of Contacts....................................................................................... 53 
Assigning Keywords.................................................................................................. 60 
Assigning Contacts to the WorkList........................................................................... 63 

Exercise 5 – Working with Campaigns............................................................................................. 68 
Recording campaign details....................................................................................... 68 
Adding and removing Targets.................................................................................... 70 
Adding and removing Respondents............................................................................ 70 
Tracking Targets and Respondents............................................................................ 71 
Adding Opportunities to Respondents........................................................................ 72 
Adding Tasks/Activity Notes to Campaigns............................................................... 73 
Mail merging documents........................................................................................... 73 

Exercise 6 – Working with Oppor tunities......................................................................................... 74 
Setting the Sales Stages............................................................................................. 74 



 

  

Contents 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

Adding new opportunities.......................................................................................... 75 
Managing opportunities............................................................................................. 75 
Measuring results ...................................................................................................... 79 
Reviewing Closed Opportunities ............................................................................... 79 

Exercise 7 – Working with your  Calendar ........................................................................................ 80 
Where can I add an appointment?.............................................................................. 80 
Using Calendar views................................................................................................ 80 

Exercise 8 – Working in MS Outlook mode...................................................................................... 82 
Viewing your Outlook folders within Legrand CRM ................................................. 82 
Transferring Outlook items into Legrand CRM.......................................................... 82 

Exercise 9 – Working in Cust.Service mode..................................................................................... 84 
Adding a new Cust.Service item................................................................................ 84 
Assigning a Cust.Service issue .................................................................................. 85 

Exercise 10 – Mail Merge.................................................................................................................. 86 
Letters and Faxes....................................................................................................... 86 
Email ......................................................................................................................... 88 
Labels........................................................................................................................ 91 
Envelopes.................................................................................................................. 91 
Campaign mode......................................................................................................... 93 

Exercise 11 – Creating merge templates........................................................................................... 94 
Introduction............................................................................................................... 94 
Fieldcodes................................................................................................................. 94 
Screen labels that have been renamed........................................................................ 94 
Document merging relationships ............................................................................... 95 
MS Word templates................................................................................................... 96 
HTML templates for personalized email .................................................................... 97 

Exercise 12 – Repor ts......................................................................................................................... 99 
Pre-formatted, unchangeable ..................................................................................... 99 

Exercise 13 – Personalising Legrand CRM .................................................................................... 101 
Common across all editions..................................................................................... 101 
Define Sales Stages................................................................................................. 102 

Exercise 14 - Menu functions........................................................................................................... 103 
File.......................................................................................................................... 103 
Edit ......................................................................................................................... 105 
Administration......................................................................................................... 106 
Report ..................................................................................................................... 107 
Help ........................................................................................................................ 108 

 

 



 

  

Assumptions and prerequisites 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

�  Legrand CRM version 4.20 (STD, PRO or CORP) is installed and is opened 
on your PC. 

�  Module and field names have not been changed. 

�  Demo database is selected 

�  To demonstrate fax merging, WinFaxPro is installed  

�  To demonstrate Outlook integration, Outlook 2000 or above is installed 

�  To create your own custom reports in Crystal Reports Professional is installed 
and fully licenced. 

�  Legrand CRM uses Microsoft Office (i.e. Word and Excel) for reporting, and 
mail merge.  If you do not have Microsoft Word and Excel installed you will 
not be able to run the reports or perform mail merge. 

�  Legrand CRM requires Microsoft Internet Explorer (IE) V5.5 or higher. 

�  Supported Windows platforms are Win2000 and Windows XP.   

�  Outlook Express, Win95, Win98 and ME are not supported. 



 

  

Legrand CRM edition and version in use 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

Legrand CRM edition and version in use 

Start up screen 
Using the information on the start up screen you can determine the 
version number and Legrand CRM Edition you are using. 

 

 

 

 

 

 

 

 

 

 

Help About 

Using the � � � �  menu select � � � � 	 .   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1 - Legrand CRM login screen 
 

 
Figure 2 - Legrand CRM Help About screen 
 



 

  

Legrand CRM edition and version in use 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

This screen displays the version, serial number and Legrand CRM 
Edition currently under use. 

Entering licence codes 

Select the 
 � � � � 
 � � � � � � � �  button.  From the presented screen enter, 
the serial number, licence key, Customer Service and Item Tracking 
option and Accounting option codes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remember to select the � � � � � � � � � � � �  button to complete the 
procedure. 

 

 
Figure 3 - Legrand CRM PRO and CORP Editions Help>About screen 
 

 
Figure 4 - Legrand CRM STD Edition Help>About screen 
 



 

  

right mouse button menu menus references 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

right mouse button menu menus 

right mouse button menu is an acronym for Right Mouse Button. 

Company mode 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

Exercise 12 – Reports 

Exercise 4 – 
Working with Lists 

Exercise 2 – Working 
in Companies mode 

 

Same as double click 

Exercise 3 – Working in 
Contacts mode 

Exercise 10 – Mail Merge 

 

 



 

  

right mouse button menu menus references 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� �

Contact Mode 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

 

 

Exercise 10 – Mail Merge 
 

Exercise 4 – Working with Lists 

Exercise 10 – Mail Merge 

 

Exercise 8 – Working in MS 
Outlook mode 

Exercise 12 – Reports 

Exercise 12 
– Reports 

 



 

  

right mouse button menu menus references 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Campaign Mode 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   
 

Exercise 5 – Working 
with Campaigns 

 

Exercise 10 – Mail 
Merge 

Exercise 5 – Working 
with Campaigns 

Exercise 10 – Mail 
Merge 



Legrand CRM product mix diagram 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

 

 

 

 

 

 

 

 

 

 

 

 

STD PRO CORP

Companies/Account management X X X

Contact management X X X

Keyword Information Tags for mailing lists & groups X X X

Marketing Events & Campaigns X X X

Sales Opportunities X X X

Group Calendar with colour coding per User X X X

Microsoft Word mailmerge X X X

HTML email & email templates X X X

Direct access to Outlook folders with bi-directional transfer X X X

Optional modules available X X

Personalised email (i.e. email mail-merge) X X

Lapsed Customer reporting X X

Duplicate Checking (V4) X X

Multi-value database Quicksearch (V4) X X

TAPI support for incoming phone calls (V4) X X

Client/Server application X

SQL Server scalability & performance X

USER CONTROL

Login name & password X X X

User Rights
Control the functions a User can access

SYNCHRONISATION

Data Synchronisation

Restricted Synchronisation

SQL Synchronisation

OPTIONAL MODULES

Customer Service module N/A $ $

Item Tracking module N/A $ $

Bundle: Customer Service + Item Tracking modules N/A $ $

Accounting interface N/A $ $

DATABASE

Database
FoxPro 
(DBF)

FoxPro 
(DBF)

SQL

X X

Uses Microsoft SQL Server's native 'Publish & Subscribe' 
functionality to deliver high-performance data synchronisation 
over LAN, WAN, VPN.

X X

X

Laptop Users can perform a LAN synchronisation between 
their local database and the master database.  

Control which Users can synchronise data and control 
whether Laptop Users can receive all the data from the master 
database or only updates to their own records.

X

 
 



Exercise 1 – Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Exercise 1 – Overview of modes 

In this exercise, you will learn about the different modes within Legrand CRM and 
how they inter-relate.  

With the completion of this exercise, you should be able to: 

·  Navigate the different modes in Legrand CRM and find information 

·  Use the Action bar buttons 
 
 
 

NOTE:  The following tool bar displays all possible items, including Options.  See 
the Legrand CRM product mix diagram, Figure 3 and Figure 4. 

 
 
 
 
Mode buttons are located with the Menu bar: 
 
 
 
 

 
 
 
 

Figure 5 – Legrand CRM toolbar . 

Navigation bar 

Menu bar 



Exercise 1 – Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Companies mode 
1 Click on � � � � � � � � 	  navigation button  

NOTICE: There is an Action bar panel to the left and 4 
distinct panes containing information.  The first being the:  

·  � � � � � � � � � � � 	 � 
then to the right  

·  � � � � � � � � � � � � � � � 	 � � �  
·  � � � � � � � � 
 � 	 � � � �   
·  � � � � � � � � � � � � 	 � � � � � � � �  

Action bars 

2 Click on � � 
 � � � � � � � � 	  Action button. 

NOTE: The title above the Company list is now My 
Companies 

You now can view all the Companies who have an Account 
Manager set to the currently logged in user (you!). 

3 Click on 
 � � � � � � � � � � 	  Action button. 

NOTE: The title above the Company list is now All 
Companies 

All companies in your database are now displayed. 

HANDY! By typing in the first letters of the Company name, 
the list will jump down to the nearest match. 

4 Click on � � � � � �  � � � � � � � �  Action bar. 
Displays a dialogue box providing a complex search for all 
Companies in the database.  More on this in Exercise 4 ± 
Working with L ists. 

5 Click on 
 � �  � � � � � � �  Action button 
Displays an entry form to add a new Company.   

NOTE: You have the option of adding a Contact at this time.  
Simply check the box labeled � � � � 	 � � � � � 	 � � 	  in the bottom 
right corner.  You will be presented with a Contact entry form 
once the Company is created. 

6 Click on 
 � �  � � � � � � �  Action button. 
Displays an entry form to add a new Contact to the selected 
Company. 

NOTE: You have the option of changing the Company to 
which this Contact will be added.  You can also add an 
Activity Note to the new Contact simply by checking the box 

 
Figure 6 - Companies 
Action bar . 
 

 

 

 

 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

labeled � � � � 	 � � � � 	 � � � 	 � � � � 	 � . 

7 Click on � � � � �  � � � � � �  Action button 
This button will produce a predefined report of the currently 
selected Company details.  The dialogue box presents you with 
a chunky filtering option for the details contained in the 
Company report.  The report will contain Contact details and 
details of: 

·  Appointments 
·  Opportunities 
·  Tasks 
·  Activity Notes 

 
Select the appropriate radio button to change the filter for the 
above details. 

NOTE:  If the filter does not produce any data for the 
selected Company then nothing more than the Company and 
Contact details will be included in the report.   

 

Company list pane 

NOTE: There are 2 accessible QuickList drop-down selectors 
located at the top of the � � � � � � � 
 � � 	 �  pane.  They are labeled 
� � � 	 � � � � � � � � � � 
  and � � � 	 � � � �  � � � .  To find out more about 
QuickList selectors see Exercise 4 ± Working with Lists. 

1 Click in the � � � � � � � 
 � � 	 �  pane and then start typing letters, 
eg “ f”  then “ i” .  The cursor will jump to the nearest Company 
name matching the letters you typed.  Notice how the cursor 
jumps to the company “FinancePlus Software” . 

NOTE:  The � � � � � � � 
 � � 	 �  pane can be resized by dragging 
the right edge with the mouse cursor. 

2 Click inside the � � � � 	 � �  field and type in “Australia” .   

NOTICE: how the field turns yellow to indicate the active 
field.   

NOTICE: the � � � �  and � � � � � � buttons appear in the top 
right corner. 

3 Click on the � � � �  button. 

 

 
Figure 7 - Companies L ist pane 
 

 

QuickLists 

Click in list and 
start typing first 
letters of 
Company name 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

 

       Company information pane 

NOTICE:  Underlined fieldnames indicate that a function will be 
performed when clicking on the fieldnames.  The functions are listed 
below: 

·  � � � � � � � � ! � � � � � � 	 � � �  ± Add new Company, Add Contact to 
selected Company, and Print Report.  

·  � � � � � � �  ± Search by Company name 

·  � 	 � � � 	 �± Toggle between Street address and Postal address 

·  " � � � � �± Dial number 

 
 
 
 
 
 
 
 
 
 
 
 

1 Click on the � 	 � � � 	  fieldname.   

NOTICE: how the � 	 � � � 	  address information changes to 
# � � � � � �  address information. 

2 Click on the � � � � � � �button in the top right of the pane, near 
� � � � � � 
 �  field.  You can assign additional Keywords to this 
Company using this dialogue box.  Adding a new Keyword by 
simply selecting � 
 
  button and typing a new Keyword.  More 
on how to use Keywords in Exercise 4 ± Working with L ists. 

 
Figure 8 - Company Information pane 
 

Click here to reveal 
a menu 

Click here to search 
for a Company 

Click here to reveal 
Mailing fields Click here initiate 

TAPI dialling 
interface 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Company detail tabs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Click on the � � � � � � � �  tab.  This tab name can be redefined.  By 
double clicking on any name Legrand CRM changes into 
Contact mode allowing you to work on the Contact in one 
simple step.  More on Contacts in Exercise 3 ± Working in 
Contacts mode.  (If you have already double clicked on a 
Contact name then simply select the � � � � � � � � 	  mode 
button located across the top of the screen to take you back.) 

NOTE:  By selecting a Contact name from this tab and using 
the right mouse menu, you may perform a number of actions 
such as adding a new Appointment, Activity Note, Task or 
Cust.Service item (Cust.Service only in PRO or CORP 
editions). 

2 Click on the � � � � 	 � �  tab.  This tab name cannot be redefined.  
This is where you can enter notes about this company that are 
not date related, meaning it is generic company information. 

3 Click on the 
 � � � �  tab.  This tab name can be redefined.  This 
tab contains fields that can be redefined as per your 
requirements.  Each fieldname can be redefined, and each text 
field can be resized up to 254 characters. 

4 Click on the 
 � � � 
  tab.  This tab name can be redefined.  This 
tab contains fields that can be redefined as per your 

 
 
Figure 9 - Company Detail tabs 
 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

requirements.  Each fieldname can be redefined, and each text 
field can be resized up to 254 characters. 
Info2 tab also contains a $ � 
 � � � � 	 � � � � � %�field allowing you to 
reference companies together.  For example you may want to 
track which company referred yours onto another.  This way 
you can quickly find who is providing the most referrals.  

5 Click on the � � � � � � � �� �  tab.  This tab name cannot be 
redefined.  Information contained in this tab is protected and 
cannot be edited.  Data is imported from supported accounting 
packages using the optional Accounting Link interface module.  
Use the &�� � ' � � � � � � � 	 � � � �command(�

Without the Accounting Link optional module accounting data 
can still be imported using a .csv file.  See the sample .csv file 
in your LegrandCRM directory. 

6 Click on the � � � � � 	 � � � �tab.  This tab name can be redefined.  
Although the tab name is � � � � � 	 � � � � � it is possible to attach 
any file type, not just documents.  Click on the � 
 
  button and 
then the )  button (ellipses button).  Browse your drive to find 
the file to attach.   

REMEMBER:  You have to fill in the &�� � �* � � � � � � 	 � � � �
field. 

7 Click on the � � � � � �� 	 � � 	 � �  tab.  This tab can be renamed.  It 
displays those Companies that have been linked to the selected 
Company using the + � � � � � " � � � � 	  field located in the 
 � � � 
  
tab.

 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Company relationship tabs 

NOTE:  These tab names cannot be renamed. 

 
 
 
 
 
 
 

 
 

 

1 Click on the � � �	 � � � � � � � 	 � � �  tab.  Any Calendar Events that 
have been created for any Contact in this Company will appear 
under this tab.   

2 Click on the � � � �� �� � � � � � 	 �  tab.  View of all the Activity notes 
entered for Contacts in this Company. 

3 Click on the � � �  �  tab.  View of all the Tasks assigned to this 
Company. 

4 Click on the ! � � � � � � � �� �	 � �tab.  View of all the Opportunities 
assigned to this company. 

5 Click on the � � � � � � 	 � � " 	 � � �� 	 �tab. View of all the Service 
items assigned to this company. 

NOTE:  The � � � � � � 	 � � " 	 � � �� 	 �tab appears when the 
optional module licence is entered in PRO and CORP 
editions, but not in the STD edition. 

6 Click on the 
 � 	 � � � tab.  View of all the serial numbers 
assigned to this company. 

NOTE:  The 
 � 	 � � �tab appears when the optional module 
licence is entered in both PRO and CORP editions, but not in 
the STD edition. 

 
 

 
Figure 10 - Company relationship tabs. 
 

PRO/CORP Editions Optional modules STD edition 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Contacts mode 
1 Click on � � � � � � � 	  mode button. 

NOTICE: there is an Action bar to the left and 5 distinct 
panes containing information.  The first being the:  

·  � � � � � � � 	 
 � � 	 � � 
 then to the right  

·  � � � � � � � 
 � � � � � � � � � � �  
·  � � � � � � � 	  
·  � � � � � � �  � � � � � � 	   
·  � � � � � � �  � � � � � � � � 	 � � � 	  

Action bar 

2 Click on � �  � � � � � � � 	  Action button 

NOTE: The title above the Contacts list is now My Contacts 

You now can view all the Contacts who belong to a Company 
for which you are the Account Manager. 

NOTE:  You can quickly sort into Company order by double 
clicking on the Company column title. 

3 Click on 
 � � � � � � � � � 	  Action button 

NOTE: The title above the Contacts list is now All Contacts 

All the Contacts in the database are listed in alphabetical order. 

HANDY! By typing in the first letters of the Contact’s 
surname, the list will jump down to the nearest match. 

4 Click on � � � � � �  � � � � � � � �  Action button 
The entry form that is presented to you is a filtering criteria 
dialogue box.  By choosing a radio button it allows you to 
perform two types of logic filtering: AND and OR.   
Simply stated: 
AND filtering means only those Contacts that have all 
matching criteria will be displayed;   
OR filtering means that any Contact that matches any one of 
the criteria will be displayed. 

USEFUL:  Legrand CRM makes light work of very complex 
and intricate filtering requirements using WorkList, 
Keywords and QuickSearch.  More in Exercise 4 ± Working 
with Lists. 

5 Click on � � � � � � 	 �  Action button 
Only those Contacts that have been assigned to the WorkList 

 
Figure 11 -  
Contacts Action 
bar . 
 

 



Exercise 1 ± Overview of modes 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

are displayed.  More on this in Exercise 4 ± Working with 
Lists. 

6 Click on 
 � �  � � � � � � �  Action button 
Displays an entry form to add a new Contact to the selected 
Contact’s company. 

NOTE: You have the option of changing the Company to 
which this Contact will be added by clicking on the � � � � � �  
button alongside the � � � � � � �  field.  You can also add an 
Activity Note to the new Contact simply by checking the box 
labeled � � � � 	 � � � � 	 � � � 	 � � � � 	 � ( 

7 Click on 
 � �  � � � �  Action button 
Opens an entry form to add a new Activity Note to the 
currently selected Contact. 

8 Click on 
 � �  � � � � � � � �  Event Action button 
Opens an entry form to add a new Calendar Event to the 
currently selected Contact. 

9 Click on 
 � �   � 	 �  Action button 
Opens an entry form to add a new Task to the currently 
selected Contact. 
 

Contact list pane 

NOTE: There are 2 accessible filter drop-down selectors located at 
the top of the � � � � � � � 
 � � 	 �  pane.  They are labeled � � � 	 � � � �
� � � � � � 
  and � � � 	 � � � �  � � � . 

1 Click in the � � � � � � � 
 � � 	 �  pane and then start typing letters, eg 
ªsº then ªmº.  The cursor will jump to the nearest Company 
name matching the letters you typed. 
Notice the cursor jumps to the Contact name ªSmithº. 

NOTE:  The � � � � � � � 
 � � 	 � �pane can be resized by dragging 
the right edge with the mouse cursor. 

 
Figure 12 - Contact L ist pane. 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Contact information pane 

NOTICE:  Underlined fieldnames perform actions.  The following 
fieldnames will perform the listed actions. 

·  � � � 	 � � 	 � ! � � � � � � 	 � � �  ± Add new Activity Note, Appointment, 
Opportunity or Task  

·  � � � 	 � � � � �  ± Search by last name 

·  � � � � � � �  ± Open Company mode with Company as its focus. 

·  " � � � �  ± dial number 

·  " � � � � , �± dial number 

·  # � � � � �  ± dial number 

·  - � � � � .  ± create email to address 

·  - � � � � ,  ± create email to address 

 

 
 
 
 
 
 
 
 
 

2 Click inside the empty " � � � �  field and type ª123º.   

NOTICE: The field turns yellow to indicate the active field.   

NOTICE: The � � � �  and � � � � � � buttons appear in the top 
right corner. 

3 Click on the � � � �  button 
 

 
Figure 13 - Contact Information pane. 
 

Underlined fields 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Contact detail tabs 

 

 

 

 

 

 
 

 

 

1 Click on the 
 � � � � � tab.  This tab name can be relabeled.   
This tab contains fields that can be redefined to hold up to 254 
characters.  

2 Click on the 
 � � � 
  tab.  This tab name can be relabeled.   
This tab contains fields that can be redefined to hold up to 254 
characters.   

3 Click on the 
 � � � # tab.  This tab name can be relabeled.   
This tab contains fields that can be redefined to hold up to 254 
characters.  The pop down selection fields can contain an 
unlimited number of entries. 

4 Click on the � � � � 	 � �  tab.  This tab name cannot be relabeled.   
This tab contains a single text field in which you can enter 
notes related to this contact that do not require a date and time 
reference; e.g. partners name, notes on previous history, 
hobbies, interests.   

NOTE:  Use an Activity Note to store historical data or 
information that requires chronological reference. 

5 Click on the � � � � 	 � � � tab.  This tab name cannot be relabeled.   
In the fields presented in this tab, an additional address may be 
recorded, usually the personal address of this contact.  Using 
the / � � � 	 � � � � � � � � � � � � � � 
 
 � � � �  check box any merged 
documents will use this address for mailing purposes. 

6 Click on the � � 
 � 	 � tab.  This tab name cannot be relabeled.   
Date of creation and last edit are recorded here. 

NOTE: Information contained in this tab is protected and 
cannot be changed manually. 

 
Figure 14 - Contact Detail tabs 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Keywords pane 
 

1 Click on the � � � � � �  button alongside the � � � � � � 
 �  field.  
From the window presented, keywords can be added, assigned 
and de-assigned from the currently selected Contact.  More on 
Keywords in Exercise 4 ± Working with Lists on page 60. 
 

 
Figure 15 - Contact Keywords 
pane. 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Contact relationships pane 

NOTE: Tab names cannot be redefined in this pane.   

 
 
 
 
 
 
 
 
 
 
 
 
 

1 Click on the � � �	 � � � � � � � 	 � � � �tab.   
A list of all the Calendar entries for this contact will be 
displayed. 

2 Click on the � � � �� �� � � � � � 	 � �tab.   
A list of all Activity Notes assigned to this contact will be 
displayed. 

3 Click on the � � �  � �tab. 
A list of all the Tasks assigned to this Contact will be 
displayed. 

4 Click on the ! � � � � � � � �� �	 � �tab.   
A list of all the Opportunities assigned to this contact will be 
displayed. 

5 Click on the � � � � � � 	 � � " 	 � � �� 	 �tab.   
A list of all the service issues logged by this Contact will be 
displayed. 

6 Click on the 
 � 	 � � � tab.   
A list of the entire serial-numbered items registered to this 
Contact will be displayed. 

 
 

 
Figure 16 - Contact Relationship tabs. 
 
 

PRO/CORP Edition Optional modules STD Edition 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Campaigns mode 
1 Click on � � � � � � ! �  mode button  

Action bar 

2 Click on 
 � � � � � 
 � � � � � � ! � 	 
Action button. 
By clicking on this Action button the list will be filtered to 
only those Campaigns currently active. 

3 Click on � � � � � � � � � 
 � � � � � � ! � 	 
Action button 
When this button is selected the list will display all the 
Campaigns that are no longer active. 

NOTE: The radio buttons across the top of the list of 
Campaigns performs the same function as these 2 buttons. 

4 Click on � 
 
 � � � � � � � � � �Action button 
You will be presented with an entry form to create a new 
Campaign. 

5 Click on � � � � � 
 � � 	 � 
Action button 
Creates a print preview of the current list of Campaigns with 
associated information such as Objective, costs, dates and other 
fields.  Installation of MS Word is not required for this report. 

 

 
Figure 17 - 
Campaigns Action 
bar . 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Campaign list pane 

NOTE: There are 2 filters located at the top of the � � � � � � ! � 
 � � 	 �  
pane.   

The top set consists of 2 radio buttons labeled � � � � � � 	 � � � � � � � � � � �
and � � � � � 
 � � � � � � � � � � .  The other is a pop down selector labeled 
� � � � � � � � � 	 � � � . 

These two filters work in conjunction ie logic AND 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Select the radio button labeled � � � � � � 	 � � � � � � � � � � . 

2 Click on the check box labeled � � � � � � � � � 	 � � �  and using the 
pop down selector choose * � � � � 	 � � � � �.  Only one Campaign 
fitting the filter criteria will be displayed. 

3 Uncheck the � � � � � � � � � 	 � � �  check box. 

4 Click inside the � � � � � � ! � 
 � � 	 �  pane and type ªdº. The cursor 
will jump to the first Campaign starting with that letter. 

 
 
 
 
 
 
 

 
Figure 18 - Campaign L ist pane. 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Campaign information pane 

NOTE: Field names than can be redefined in this pane are: 

o  � � �  pop down selector 

o � � 	 � � � � �  pop down selector 

o - � 	 (� � � � 	 �field 

o - � 	 (� 
 � � � � � � �field 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Campaign tabs 

NOTE: These tab names cannot be relabeled.   

 

 

 

Objective tab 

5 Use the two memo fields to enter information about the 
campaign.  Use the 0 � 1� � 	 � � �  field to describe the overall 
information about the campaign and use the � � 	 � � 2 0 � 	 � � � �  
field to tie up and resolve information about the final status of 
the campaign. 

Targets/Respondents tab 

Capture Contact names targeted for this campaign, and record those 
Contacts who respond. 

Legrand CRM allows you to identify two statuses for a Contact: 
Target and Respondent.  Each panel can be deemed to indicate 
whatever the business requirement may be.  For example if the 
campaign is in fact a company event then the 
 � � � � � 
 � � 	  panel may 

 
Figure 19 - Campaign Information pane 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

represent those Contacts who have been confirmed as attending that 
event.  Each panel is measured and displayed as a number above each 
panel of Contact names.   

 

 

 

 

 

 

 

Tasks/Activity Notes tab 

Record Tasks associated with preparing for the Campaign.  This 
section can be used as a mini project management tool.  By adding a 
series of Tasks for a particular campaign it is easy to identify those 
tasks that have and have not been completed. 

 

 

 

 

 

 

Enter Activity Notes related to this Campaign 

Sales Opportunities tab 

Record an Opportunity generated from the Campaign.  Using the right 
mouse menu a Respondent can become the source of a new 
Opportunity.  The newly added Opportunity will then become a part of 
the sales funnel process. 

 
 

 
 

 
 

 

Use right mouse 
button menu 

Add opportunity details.  
Notice that there is a 
connection to the Campaign 
from which this opportunity 
originated. 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Opportunities mode 
1 Click on " � � � � � # � � � � � 	  mode button 

USEFUL: Use the 3 � � � %� � � 	  filters at the top of the screen 
to see how your sales people are performing, by � 	 � � � , or by 
� � � � � � 	 �# � � � � � � . 

 
 
 
 
 
 
 
 
 
 
 
 
 

Action bar 

2 Click on � �  " � � � � � # � � � � � 	  Action button 
The list will show only those Opportunities that have an 
Account Manager set to the currently logged in user (you!). 

3 Click on 
 � � " � � � � � # � � � � � 	  Action button  
The list will show all Opportunities that meet the criteria 
determined by the selected radio button displayed across the 
top of the list: either Active opportunities or, Closed 
opportunities. 

4 Click on � � � � � � 
 � � � � � � � � 
Action button 
The entry form that is presented to you is a filtering criteria 
dialogue box.  By choosing a radio button it allows you to 
perform two types of logic filtering: AND and OR.   
Simply stated: 
AND filtering means only those Opportunities that have all 
matching criteria will be displayed; 
OR filtering means that Opportunities that matches any one of 
the criteria will be displayed. 

5 Click on 
 � �  " � � � � � # � � � � � 	  Action button 
In the entry form presented, most of the relevant fields can be 
filled in to prepare the Opportunity for attention.  Once saved, 
further fields may be filled in. 

6 Click on 
 � � � � 	 � 	 
Action button 
Measuring results is the key to tracking Campaign 

 
Figure 20 - 
Opportunities Action 
bar  
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

effectiveness and with Legrand CRM' s graphical tool you can 
now see how many Opportunities are in each step of your 
defined sales process. 

Use the � ! �   button on the top right of the screen to see the 
data in list format. 

7 Click on � � � � � 
 � � 	 � 
Action button 
Will print the current list to a pre-formatted report print 
preview screen from where you can elect to print to any 
installed printer. 
 
 

Calendar mode (as well as Tasks and Activity) 
1 Click on � � � � � � � � 
mode button 

Legrand CRM will initially open the Calendar in 5-day view.  
When working in Legrand CRM, the last Calendar view you 
choose will be there when you return to the Calendar mode. 

USEFUL:  Each user is displayed as a separate colour so it' s 
easy to see who is doing what, when! 

Action bar 

2 Click on * � � �4 �� �  Action button 
The Calendar view will display a single day' s calendar, 
together with a Task list to the right of the screen. 

3 Click on
5 6* � � �7 � � % Action button 
The Calendar view displays a 5-day week view. 

NOTE: The current day has an asterisk in front of it. 

4 Click on $ %& � � 
 � � � �  Action button 
Displays a 7-day week, starting on Monday on the left and 
ending on Sunday to the right. 

5 Click on � � � � � 
 ' � � �  Action button 
Displays the current month displayed as a 5 day week, with 
Saturday and Sunday as half cubes to the right of Friday. 

6 Click on  � 	 � 
 � � 	 � 
Action button 
Displays a list of Tasks assigned to the person selected using 
the pop down filter box at the top of the screen. 

7 Click on ( � � � � 
 � � 	 � 
Action button 
List of Calendar Events for the current month and the 
following month are displayed.   

NOTE: Show other events by clicking on the 

 
Figure 21 - Calendar  
Action buttons 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

� � � � � 
 � � � - � � � 	 � � � � � 	 � � � � 	 � � � �  button located in the top 
left of the screen. 

8 Click on 
 � � � � � � � 
 � � 	 � 
Action button 
This list is the list of Activity Notes created either by a user, or 
automatically by Legrand CRM. 

NOTE: More Activity Notes can be shown in this list, simply 
click on the � �  ! 4 !  8 � � � � 	 � � � � 	 � � � �  button just above the 
column headings. 

9 Click on � � � � � 
Action button. 
Clicking on this button produces a predefined report which can 
be viewed on-screen or printed to any configured printer.  MS 
Word installation is not required to run this report. 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

MS Outlook mode  
1 Click on � � 
" # � � � � � �mode button 

Tree buttons 

2 Click on � � � 	 � � � � 
) � � � � � 	 
 tree item 
If correctly configured, when you expand the Personal Folders 
tree item, your Outlook folders will appear and may be viewed 
exactly as per Outlook. 

NOTE: Sending and receiving email using Legrand CRM is 
discussed in Exercise 8 ± Working in MS Outlook mode. 

3 Select the * � � � � � � � " � � � � � �&� � 
 � � �  check box if you wish to 
view both personal and public Outlook folders.  Be aware that 
viewing public folders may take a long time to load. 
 
 

 
Figure 22 - Outlook folders and synchronisation options 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Cust.Service mode  

NOTE:  Cust.Service mode is an option for both PRO and CORP 
Editions.  The CS module is not available for the STD Edition. 

1 Click on � # 	 � *� � � � � � � �navigation button 

Action bar 

2 Click on � � 
 � � � � � � � 
+	 	 # � 	 
to view all service issues 
assigned to the currently logged on user. 

3 Click on 
 � � 
 � � � � � � � 
+	 	 # � 	 
to view all service issues that 
are currently open.  To view all the currently closed service 
issues simply click on the radio button labeled � � � � � 
 �
� � � � � � � � � � � � � �  above the left hand panel. 

4 When � � � � � � 
 � � � � � � � � 
 is selected you will be presented 
with a filtering criteria dialogue box.  By choosing a radio 
button it allows you to perform two types of logic filtering: 
AND and OR.   
Simply stated: 
AND filtering means only those Service Issues that have all 
matching criteria will be displayed;   
OR filtering means that any Service Issues that matches any 
one of the criteria will be displayed. 

5 Click on 
 � � 
 � # 	 � � � � � 
 � � � � � � � 
+	 	 # � 
to add a new 
Service Issue. 
 

 
Figure 23 - Cust. Service 
Action bar  
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Item Tracking module 

NOTE:  Item Tracking mode is an optional module available for 
both PRO and CORP editions, but not for the STD edition. 

1 Click on +� � � 
  � � � � � � ! 
mode button 

Action bar 

2 Click on � � 
button
to view all Items created by the currently 
logged on user. 

3 Click on 
 � � �button�to view all Items sold 

4 When � � � � � � 
 � � � � � � � � 
 is selected you will be presented 
with a filtering criteria dialogue box.  By choosing a radio 
button it allows you to perform two types of logic filtering: 
AND and OR.   
Simply stated: 
AND filtering means only those Items that have all matching 
criteria will be displayed;   
OR filtering means that any Items Sold that matches any one of 
the criteria will be displayed. 

5 Click on � 
 
 � � � � �button�to add a new product and serial 
number to the Items Sold list. 
 

 
Figure 24 - I tems 
Sold Action bar  
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Products mode  

NOTE:  Products mode is available for both PRO and CORP 
editions, but not for the STD edition. 

1 Click on � � � � # � � 	 
mode button.  A separate window will 
open. 

NOTE:  There is no Action bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
 
 

 

 

2 Click on the � � � 
button
to add a new Product to the list.  The 
� � �  button is located in the top right of the window. 

 
 

 
Figure 25 - Products mode screen 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Exercise 2 – Working in Companies mode 

In this exercise you will explore the features found in the Company mode and how 
you can use them in your day-to-day activities. 

NOTE: In this exercise the window pane description name will be appear in this 
font: � � � � � � 
 � � � � 
 � � � � , and the tab names will appear in this font:  � � � � � � � ( 

With the completion of this exercise, you should be able to  

·  Find a company 

·  Create a new company 

·  Add a contact to company 

·  Search for a list of companies 

Finding Companies 
Finding a company can be performed using any of 3 methods: 

Using the Company list window 

NOTE:  Sort the list simply by double clicking on the list heading. 

 

 

 

1 First of all make sure you are in the � � � � � � � � 	 
mode.   

2 Finding a company is quite easy.  Click inside the � � � � � � � 

� � 	 �  window.  Click on the 
 � � 
 � � � � � � � � 	  Action button to 
makes sure all the Companies are listed.  Type ªLeº and the 
cursor will jump to ªLegrand Softwareº 

Using Company search 

3 Alternatively, click on the field label, 

which is underlined in blue or on the  button and in the 
� � � � � � � 
 � � � � � � � � � � �  pane.  Type in ªleº and all the 
companies starting with L will be listed. 

Using QuickSearch 

4 Another method is to click on any field in the Company 
information pane and open right mouse button menu.  Select 
QuickSearch and the dialogue box presented will offer 
methods to search for Companies.   
Click in the � � � � � � �  field and right mouse button menu.  
Select the radio button labeled � 	 � � 	 � � � � 	 � .  In the field 
presented, type in Le.  Then select the� � � � � � � �button� � �A list 
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� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

of all Companies starting with ªLeº will be presented in the 
Company list pane. 

Adding Companies 
1 Click on the 
 � � 
 � � � � � � �  Action button in the left hand 

icon pane or right mouse button menu in the � � � � � � � 
 � � 	 �  
pane and select � 
 
 � � � � � � � � . 
 
 
 
 
 
 
 
 
 
 
 
 
Fill in the details of a company with the name ªWorld©s Best 
CRMº and use the Tab key to move across to each field.  Make 
sure you fill in details in the � 	 � � � 	 � � 
 
 � � � �  and the # � � � � � � �
� 
 
 � � � �  fields.  Make sure the � � � � 	 � � � � � 	 � � 	  check box is 
checked. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the � � � �  button and you are presented with an Add 
Contact entry form.  Fill in details for a ªMr James Expertº and 
click on the � � � �  button. 

2 You have now created a Company and a Contact for that 
company.   

 

 

 

OR 
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Adding Contacts to a Company 
1 If you wish to add further Contacts, simply highlight the 

company name in the � � � � � � � 
 � � 	 �  and click on the 
 � � 

� � � � � � �  Action button. 

2 Alternatively, select the Company 
in the � � � � � � � 
 � � 	 �  and right 
mouse button menu.  Choose � 
 
 � � � � 	 � � 	 � 	 � � � � � � � � � .  
 

Primary Contacts 
A Primary Contact is a status level that can be applied to only one 
person per Company.  Use this status as a method of identifying the 
one person in a Company with which you wish to correspond.  See 
Exercise 4 ± Working with Lists Search criteria for more information 
on how to filter for a list of Primary Contacts. 

1 Open the right mouse button menu on a Contact name. 

2 Select # � %� � " � � � � � � � � � � 	 � � 	 .  The name will appear with a 
person icon in the "  column. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Deleting a Company 

 

 

Primary Contact icon 

Right mouse button command to place marker 
on Contact 
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NOTE:  In PRO and CORP Editions permission to delete Companies 
is required under the User Rights settings.  See the Advanced 
Training manual for more details. 

1 Use the Edit>Delete Current Company menu command to 
delete the selected Company. 

 

 

 

 

 

 

 

 

 

 

 

Web URL field 
The Web URL field can be used for both internet addresses or to 
locate folders on your network. 

 

 

 

OR 

 

 

 

If the URL is a web site the GO button will open your internet browser 
and open the web page indicated. 

If the URL is a local path on your LAN Windows Explorer will open 
and navigate to the folder.   If you include an actual file name, it will 
be opened in the appropriate application.  For example if the URL is 
c:\temp\pr icelist.xls Excel will open and display pr icelist.xls. 
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Accounting tab 
The Accounting tab in the Company module is populated with data in 
two ways: 

1 Using Legrand CRM' s Accounting Link which supports a 
number of accounting systems.  Go to File>Accounting menu 
to find the list of supported systems. 

2 Importing a .csv file using the File>Accounting>Gener ic 
impor t from file command. 

 

 

 

 

 

 

 

3 Click on the blue underlined Accounting Menu text to display 
a menu of commands for the Accounting Link interface.  This 
menu only affects the currently opened Company.   

4 To operate the Accounting Link interface for all Companies 
use the File>Accounting menu command. 

 

 

Documents tab 
Legrand CRM allows electronic files of any type to be associated with 
a Company record.  Legrand CRM copies the selected file and stores it 
in a folder named Documents in datafile folder.  When using a 
synchronizing client Legrand CRM (STD and PRO only) will detect 
whether a new file has been added to the Documents tab and will copy 
it to the local folder when the user next synchronises.   

In Legrand CRM CORP Edition synchronization of documents is 
performed using Windows'  ªMake available offlineº feature.  This 
must be carefully setup by a person knowledgeable of how 
Legrand CRM is configured.  Windows will then automatically keep 
track of documents that have been added or changed during the period 
between synchronization. 
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IMPORTANT:  In STD and PRO Edition only.  If another user 
makes a change to the file then Legrand CRM needs to be informed 
of that change so that the document can be included with 
synchronization data the next time synchronization is initiated.      

To do this the User must select the item in the Documents tab, select 
the Rename button then click Save.  The system will now re-
synchronise that document. 

To re-synchronise documents that have been edited or altered in some 
other way, perform these steps in STD and PRO Edition. 

1 Select the Company document tab 

2 Select the Document that has been changed or edited. 

3 Click on Rename button 

4 Click on Save button 
 
To add a new document: 

1 Use the Add button to add a new entry. 

2 Use the Open button to open the selected document.  Your 
operating system will invoke the associated application.  For 
example if the selected document is a Word document then 
Word will open and display the document. 
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Exercise 3 – Working in Contacts mode 

In this exercise you will explore the features found in the Contact mode and how 
you can use them in your day to day activities. 

NOTE: In this exercise the window pane description name will be appear in this 
font: � � � � � � 
 � � � � 
 � � � � , and the tab names will appear in this font:  � � � � � � � ( 

With the completion of this exercise, you should be able to  

·  Find a Contact 

·  Add a new Contact 

·  Re-assign a Contact to another Company 

·  Search for a list of Contacts 

Finding a Contact 
1 Select the � � � � � � � 	 
mode button 

Using the Contact list 

2 Click inside the Contact list pane. 

3 Start typing ªReyº.  The cursor will jump to Reynolds 

Using Lastname search 

4 Inside the Contact information pane, click on the field label 
� � � 	 � � � � . 

5 Start typing ªReyº.  The cursor will jump to Reynolds.  All the 
Lastnames starting with R will appear, and the one that closest 
matches ªReyº will be highlighted. 

Using QuickSearch 

6 right mouse button menu inside the � � � 	 � � � � �field. 

7 Select 3 � � � %� � � � � � . 

8 Choose the � 	 � � 	 � � � � 	 �  radio button 

9 Type ªReyº into the field presented. 

10 Click on � � � � � � . 
Tr ick: Note the selection box ªAND Contact has Keywordº.  
If the check box is selected and a Keyword chosen from the 
selector the results will produce the condition AND the 
Keyword;  alternatively is the check box is not selected and a 
Keyword is chosen from the pop down selector the list of 
Contacts will be a result of the condition OR the Keyword. 

Adding a new Contact 
A Contact can be added with or without a Company reference.  When 
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adding a Contact to a Company the Company must exist in the 
database.  If the Company does not exist then simply switch to 
Company mode and add the Company first. 

1 Click on the 
 � � 
 � � � � � � �  Action button in the left hand icon 
pane.  You will be presented with an entry form to add a new 
contact to the Company of the currently selected Contact.   

NOTICE: The Company name is already filled in however 
you can change the Company name simply by selecting the 
� � � � � � �button adjacent to the � � � � � � �  field.   

If this Contact does not have a Company reference then 
whilst adding the Contact simply select the � � � � � �  button 
and choose � � � � � � � � � � � � � . 

NOTE: You can add an Activity Note at this point by 
checking the box labeled � � � � 	 � � � � 	 � � � 	 � � � � 	 � ( 

2 Alternatively, a Contact can be added by right mouse button 
menu inside the Contact list pane.  The process is then the 
same as above. 

Move a Contact to another Company 
1 From within the Contact list, select any name. 

2 In the � � � � � � � 
 � � � � � � � � � � � 
pane, click on the � � � � � �  
button 

3 Click � � � � � 	 � � � � � � � � �

 
 
 
 
 
 
 
 

4 In the dialogue box, type in the first characters of the new 
Company.  The list will display Company names starting with 
those characters. 
 
 
 
 
 
 
 
 
 
 

 
 



Exercise 3 ± Working in Contacts mode 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 Click on the name of the Company in the list.  If the required 
Company does not show up then it may not exist in the 
database and will have to be created prior to this step. 

6 Once the Company name appears, select it and click on the 
� � � � � 	  button. 

7 Click on the � � � �  button at the top right of the Legrand 
window. 
The contact has now been moved to the new company. 

NOTE: If an important Contact has left one company and 
moved on but the name of the new Company is not known 
then you can retain all the correspondence and notes for that 
Contact by moving them to a Company named, for example, 
ªUnknownº.  Within Unkown company you can store all 
those Contacts that move on and some time later appear at 
another Company and you won' t lose all that data has been 
collected over the years. 

 

Remember to remove Keywords from the Contact name so 
that you don' t include them when those keywords are 
retrieved for a mail merge.
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Exercise 4 – Working with Lists 

In this exercise, you will learn how to compile a list of Companies and Contacts.  The 
most commonly required list is one consisting of Contacts with which a report or a 
mail merge is being performed.  However, there are some occasions where Company 
lists are just as useful. 

At this point it is imperative to note that it is the WorkList that will be most often 
used when compiling a Contact List.  It is very difficult to create a query to 
accommodate every filter required so Legrand CRM solves this problem by providing 
a simple, yet very effective, temporary holding location into which each filtered 
group of names can be added, as well as removed.  This method satisfies the filter 
logic operands OR and NOT;  AND filtering is handled within the SearchCr iter ia 
function. 

With the completion of this exercise, you should be able to: 

·  Use different filters to create a list 

·  Assign Keywords to a list of Companies and Contacts 

·  Create an Activity Note for a list of Contacts 

·  Add and remove Contacts from the WorkList 

·  Use Keywords to create a list of both Companies and Contacts 

Search for a list of Companies 
Searching for a selection of Companies is an easy task in 
Legrand CRM.  Using any one of 4 methods, a selection of Company 
names can be compiled. 

Actions for the resulting list of Company names 

The resulting list of Company names from any of the following 
searches can have the following actions performed on them. 

 

8  

9  

10  

11  

 
Figure 26 ± List by actions that can be per formed on a list of 
Companies 

Export to Excel 

Assign the same 
Keyword to all 
selected Companies 

Remove a Keyword 
from all selected 
Companies 

Assign a value into a 
field to all selected 
Companies 
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QuickList - List by Keyword 
 
 
 
 
 
 

1 Using the QuickList selector across the top of the 
� � � � � � � 
 � � 	 � , a filtered list of Companies can be quickly 
viewed.  Pop down the � � 	 � 
 , � 
 � � � � � � �  box and select 
� � � � � � 
 � � 
 # � � � � � .  All the companies with the Keyword 
� � � � � � 
 � � 
 # � � � � �  will be displayed in the � � � � � � � 
 � � 	 �  
pane. 

QuickList - List by Type 

1 This time, using the QuickList selector, � � � 	 � � � �  � � � , pop 
down the box and select " � � � � � � 	 .  All the Companies of 
 � � � , " � � � � � � 	  will be displayed in the � � � � � � � 
 � � 	 �  pane. 

NOTE:  The other QuickL ist selection is automatically 
cleared. 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 27 - QuickL ist selectors 

 
Figure 28 ± List by Type QuickList selector  
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Search criteria 

1 Choose the � � � � � � 
 � � � � � � � �  Action button. 

Using AND logic 

2 Select the � � *  radio button at the top of the dialogue box. 

3 Check the � � � � � � �  check box 

4 Type ªaº into the � � 	 � � � �  field and ªLº into the � � 
  field. 

5 Check the " � � 	 � � 
 �  check box. 

6 Type ª2000º into the � � 	 � � � �  field and ª3500º into the � � 
  
field. 

7 Select the - 9� � � 	 �  button 

8 The displayed lists of Companies are now those that start with 
the letters A through to L, AND have a postcode between 2000 
and 3500. 

NOTICE:  There should be 11 Companies displayed in the 
list.  If not, record the number of Companies to compare with 
the following steps. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 29 ± Using AND logic f ilter ing 
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Using OR logic 

9 Choose the � � � � � � 
 � � � � � � � �  Action button. 

10 Select the 0 
  radio button at the top of the dialogue box. 

11 Check the � � � � � � �  check box 

12 Type ªaº into the � � 	 � � � �  field and ªLº into the � � 
  field. 

13 Check the " � � 	 � � 
 �  check box. 

14 Type ª2000º into the � � 	 � � � �  field and ª3500º into the � � 
  
field. 

15 Select the - 9� � � 	 �  button 

16 The displayed list of Companies are now those that start with 
the letters A through to L, OR have a postcode between 2000 
and 3500. 

NOTICE:  There are now 19 companies displayed in the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

17 Click on 
 � � 
 � � � � � � � � 	  or � � 
 � � � � � � � � 	  to clear the 
filter. 

 

 
Figure 30 ± Using OR logic filter ing 
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QuickSearch feature in Company module 

The QuickSearch feature is one of the most useful and easy to use 
searching features in Legrand CRM.  By simply using the right mouse 
button menu on almost any field, a filter can be quickly created and a 
list of Companies displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

QuickSearch on Text fields 

1 Click on the � � 	 �  field. 

2 right mouse button menu.  Select 3 � � � %� � � � � �  

3 In the dialogue box choose the � 	 � � 	 � � � � 	 �  radio button 

4 Type ªHº into the presented field. 

5 Click on the � � � � � �  button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 31 - QuickSearch r ight mouse button menu menu. 
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QuickSearch on pop down selection fields 

1 Click on the ! � 
 � � 	 � �  field. 

2 right mouse button menu.  Select 3 � � � %� � � � � �  

3 In the dialogue box (Figure 27) choose the � � � 	 � � � � �radio 
button 

4 Using the pop down selector, choose !   

5 Click on the � � � � � �  button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE:  All drop-down selectors in the Company module use 
the same QuickSearch mechanism as shown above.  However 
in the Contacts module the drop-down selector QuickSearch 
is different. 

 
 

 
Figure 32 - QuickSearch on a Company drop-down selector . 
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QuickSearch on Date fields 

1 Click on the 
 # � � � 
 tab. 

2 Click in the � � � 	 � � � � � � � 
  field 

3 Open the right mouse button menu.  Select 3 � � � %� � � � � � � �

NOTICE:  The radio button selections are now date 
orientated. 

4 In the dialogue box choose the : � 	 � � � � �radio button. 

REMEMBER:  If you use the : � 	 � � � �  search, if you are 
searching for all changes for the date range of 
01/07/03 to 30/06/04 then the date filter must be set one day 
either side eg. 30/06/03 to 01/07/04. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 In the first date field type º01/01/01º and in the second date 
field type ª01/06/03º 

6 Click on the � � � � � �  button. 

Hint to find blank dates:  If you need to find all records that 
have a blank date field then simply perform a search on a date 
Before 01/01/1000. 

 

 
Figure 33 - QuickSearch dialogue box for  a date field. 
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QuickSearch on Number fields 

1 Click on the +� � � - 
tab. 

2 Click in the � � � � � � . �field 

3 Open the right mouse button menu.  Select 3 � � � %� � � � � � � �

 

 

 

 

 

 

 

 

 

 

4 Using the drop-down selectors choose the type of parameter 
required.   

5 Select the And and Or radio button for the logic required. 

6 Click Search to execute. 

 

 

 
Figure 34 - QuickSearch dialogue box for  a number  field. 
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Search for a list of Contacts 
Searching for a selection of Contacts is an easy task in Legrand CRM.  
Using up to four methods, a selection of Contact names can be 
compiled for any required purpose. 

Actions for the resulting list of Contact names 

The Contacts module is by far the most functional module in Legrand 
CRM for performing actions on Contact.  This makes perfect sense in 
light of requirements of a sales and marketing focused organization.  
Actions such as mail merge, assigning keywords and values, exporting 
lists, printing labels and envelopes all revolve around Contacts. 

The actions that can be performed on a list of Contacts is accessed via 
the right mouse menu. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 35 ± Actions that can be per formed on a list of Contact names 
available from the r ight mouse menu. 
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QuickList - List by Keyword 

1 Using the QuickList selector across the top of the � � � � � � � 

� � 	 � , a filtered list of Contacts can be quickly viewed.  Pop 
down the  � � 	 � 
 , � 
 � � � � � � �  box and select � � � � � � 	 	 � � .  All 
the Contacts with a Keyword of Newsletter will be displayed in 
the � � � � � � � 
 � � 	 �  pane. 

 

 

 

 

 

 

 

 

 

 

QuickList - List by Type 

IMPORTANT: The � � � 	 � � � �  � � �  QuickList uses the Company' s 
 � � � �as its filter.  If the Contact is not associated with a company 
then it will never appear in the QuickList results. 

1 Using the QuickL ist selector across the top of the � � � � � � � 

� � 	 � , a filtered list of Contacts can be quickly viewed.  Pop 
down the � � � 	 � � � �  � � � �box and select " � � � � � � 	 .  All the 
Contacts that are associated with Companies of  � � � , 
" � � � � � � 	 , will be displayed in the � � � � � � � 
 � � 	 �  pane. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 36 ± Using the QuickL ist to retr ieve a list of Contact names. 

 
Figure 37 ± Using the QuickL ist to retr ieve a list of Contact names who 
are linked to Companies of Type “ Customer” . 
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NOTE:  The other pop down selection � � � 	 � � � � � � � � � � 
  is 
automatically cleared. 

 

Search criteria 

Using the Search Criteria button filters using AND and OR logic can 
be performed.   

 

 

 

 

1 Choose the � � � � � � 
 � � � � � � � �  Action button. 

Using AND logic 

2 Select the � � *  radio button at the top of the dialogue box. 

3 Check the � � � 	 � � � �  check box 

4 Type ªaº into the � � 	 � � � �  field and ªLº into the � � 
  field. 

5 Check the � � � � � � 
 . �check box. 

6 Choose � � � � � � 	 	 � �  from the pop down selector. 

7 Select the - 9� � � 	 �  button 

8 The displayed list of Contacts are now those whose Lastname 
start with the letters A through to L, AND have a keyword of 
Newsletter. 

NOTICE:  There should be 3 Contacts displayed in the list.  
If there are not 3 then record the number of Contacts to 
compare with the following steps. 

 
Figure 38 ± Search Cr iter ia action button in Contacts module 
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Using OR logic 

9 Choose the � � � � � � 
 � � � � � � � �  Action button. 

10 Select the 0 
  radio button at the top of the dialogue box. 

11 Check the � � � 	 � � � � �check box 

12 Type ªaº into the � � 	 � � � �  field and ªLº into the � � 
  field. 

13 Check the � � � � � � 
 . �check box. 

14 Choose � � � � � � 	 	 � �  from the pop down selector. 

15 Select the - 9� � � 	 �  button 

16 The displayed list of Companies are now those that start with 
the letters A through to L, OR have a keyword of Newsletter. 

NOTICE:  There are now 23 Contacts displayed in the list. 
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QuickSearch feature in Contacts module 

The QuickSearch feature is one of the most useful and easy to use 
searching features in Legrand CRM.  By simply right mouse button 
menu on almost any field, a filter can be quickly created and a list of 
Contacts displayed. 

And Contact has Keyword selection 

One very important addition in QuickSearch in the Contacts module is 
the addition of the ªAnd Contact has Keywordº selection. 

 

 

 

 

 

 

 

 

A typical filter scenario is when a Contact list is based on fields in the 
Company module. 

 

QuickSearch on Text fields and drop-down selection 

In the Contact module the QuickSearch feature uses the same dialogue 
box on both text fields and drop-down selectors. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 39 ± Using the “ And Contact has Keyword”  feature in the 
QuickL ist it is possible to combine filters created in Search Cr iter ia and 
WorkL ist. 

     
Figure 40 - QuickSearch dialogue box for  text fields and drop-down fields in the Contact 
module.  Note the Multi-Value radio button found in PRO and CORP Editions only. 
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1 Click on the 
 � � � �  tab 

2 Click on the / � � � . �field. 

3 Open the right mouse button menu.  Select 3 � � � %� � � � � �  

4 In the dialogue box choose the ! � � � 0  � - � � 	 � �radio button 

5 Click on the � � � � � �  button. 

6 The � � � � � � � 
 � � 	 �  now contains only those Companies who 
have no text in the / � � � .  field. 

QuickSearch on Date fields 

1 Click on the � � � ��  tab. 

2 Click in the � � � 	 � � � � � � � 
 � � �  field 

3 right mouse button menu.  Select 3 � � � %� � � � � � � �

NOTICE:  The radio button selections are now date 
orientated.  

4 In the dialogue box choose the : � 	 � � � � �radio button. 

REMEMBER:  If you use the : � 	 � � � �  search, to find all 
changes for the date range of 01/07/03 to 30/06/04 then the 
date filter must be set one day either side eg. 
30/06/03 to 01/07/04. 

5 In the first date field type º01/01/01º and in the second date 
field type ª01/06/03º 

6 Click on the � � � � � �  button. 
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QuickSearch on Number fields 

1 Click on the 
 � � � �  tab and click inside the Number1 field. 

2 Click in the � � � � � � . �field 

3 Open the right mouse button menu.  Select 3 � � � %� � � � � � � �

 

 

 

 

 

 

 

 

 

4 Using the drop-down selectors choose the type of parameter 
required.   

5 Select the And and Or radio button for the logic required. 

6 Select a Keyword if the filter is being applied to a group of 
Contacts identified with a particular Keyword. 

7 Click Search to execute. 

 
Figure 41 - QuickSearch dialogue box for  a number  field. 
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Assigning Keywords 
The keyword feature helps to easily identify which records with a 
common relationship or in a common group .  For example, the list of 
companies using competitive products may need to be tracked.  By 
using Keywords, lists of Companies can be retrieved immediately. 

NOTE: Company Keywords and Contact Keywords are independent 
of each other. 

Assigning Keywords to Companies 

There are 2 methods to assign Keywords to Companies.  One is to 
allocate Keywords to a single company; the other is to assign the 
Keyword to multiple companies.   

We are going to create a new Keyword with which to track companies 
using a competitor' s product and allocate that Keyword to a list of 
companies.   

1 Create a new Company Keyword by selecting the � � � � � � �
button found in the top right-hand corner of the � � � � � � � 

� � � � � � � � � � �  pane.   
 
 
 
 
 
 
 
 
 

2 Click on the � � �  button.   
 
 
 
 
 
 
 
 
 
 
 
 

3 Type in the word ªUser-Brand Xº then click on the � � � �  
button then on the � � � � � �  button.  The new Keyword is now 
available for use. 
 

 
Figure 42 ± Change button used to edit Keyword list. 
 

Change button. 

 
Figure 43 ± Use the New button to add a new Keyword to the list. 
 

New button. 
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4 In the Company list, hold down the Ct r l  key on the keyboard 
and click on a number of Company names. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 Activate the right mouse button menu over the top of a selected 
company name and select � � � � � � � � � � � � � 
 � 	 � � � � � � � 	 � 
 . 

6 From the dialogue box select / � � � -: � � � 
 � ;  and click on the 
blue right arrow to assign it. 
 

 

 

 

 

 

 

 

 

 

7 Click on the Save button.  

8 Now we will add to our more companies to the Keyword User-
Brand X.  Let' s add all Companies with a Postcode beginning 
with 3.  Click inside the " � � 	 � � 
 �  field and right mouse 
button menu. Choose 3 � � � %� � � � � � ( 

 
Figure 45 - Assigning Keywords to a list of Companies. 

 
Figure 44 ± Use the Ct r l  key to select multiple Company names, or  
simply use a filter .  Choose Select All if all are to be actioned. 

Use these blue arrows 
to assign and remove 
keywords. 
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 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

9 Select � 	 � � 	 � � � � 	 �  radio button 

10 Type ª3º into the presented field. 

11 Click on � � � � � �  button.  Five companies should now be in 
your � � � � � � � 
 � � 	 � . 

12 Click inside the Company list and right mouse button menu. 

13 Choose � � � � � 	 � � � �.  All items should be highlighted. 

14 With the cursor over one of the highlighted Company names, 
right mouse button menu and select 
� � � � � � � � � � � � � 
 � 	 � � � � � � � 	 � 
 . 

15 From the list select / � � � 6: � � � 
 � ;  and then the blue right 
arrow button. 

16 Click on � � � � . 

17 To list all Companies with the Keyword / � � � 6: � � � 
 � ; , select 
it from the QuickList drop-down selector, � � � 	 � � � � � � � � � � 
 , 
located above the � � � � � � � 
 � � 	 � .  A filtered list of Companies 
is now displayed. 

NOTICE: By using a Keyword and using a combination of 
search methods, a complex filtered list of Company names 
can be created for retrieval at any time. 

18 With this newly created list of Brand X users, you can merge to 
a personalized document, fax or email.  See Exercise 10 ± Mail 
Merge for more detail. 
 
 

Assigning Keywords to Contacts 

The keyword feature is a mechanism to identify which record has a 
common relationship with other records.  For example, the list of 
Contacts to which you send Christmas cards may not be the same each 
year.  This being the case a keyword can be created for each year eg. 
ChristmasCard2004, ChristmasCard2005 and ChristmasCard2006.  
When the list of Contacts is compiled the entire list may be assigned 
the appropriate keyword. 

NOTE: Company Keywords and Contact Keywords are independent 
of each other. 

Creating and assigning keywords to Contacts is no different to the 
process detailed above for the Company module, however when the 
list of Contact names is compiled use the � � � � 	 � � � � � � � � � 	 	 � � �
� � � � ' � � � � � �  menu.  See Figure 31. 
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Assigning Contacts to the WorkList 
The WorkList is a temporary work space where a collection of Contact 
names can be stored.  The most important thing to remember about the 
WorkList is that it is the only location within Legrand CRM from 
where names can be added and removed for the purposes of 
performing actions.  The WorkList is stored locally (not shared or 
viewed by other users as is the Keyword list) and is cleared when 
Legrand CRM is closed.  The benefit of the WorkList is that it can be 
used as a temporary holding location of names from which more 
names can be added or removed.  In this example we will use the 
WorkList to compile a list of Contacts to be assigned to a Keyword, a 
Campaign and to append text to the � � � � � � 	  field. 

WARNING:  The WorkList is temporary and it will reset when your 
Legrand CRM session terminates. 

 

We will compile a list of Contact names using each of the methods 
outlined above. 

1 Ensure Legrand CRM is in Contact mode by selecting the 
� � � � � � � 	  mode button. 

2 Click on 
 � � 
 � � � � � � � 	  Action button 

3 Holding down the Ct r l  key, select 2 or 3 names from the list. 

4 With the cursor over the top of a highlighted name, right mouse 
button menu and select 7 � � %� � � 	 ' � 
 
 � 	 � �7 � � %� � � 	  

5 Now click on the � � � � � � 
 � � � � � � � �  button 

6 Click on 0 
 ' ! � � " � � � � � � � � � � 	 � � 	 � � 	 �
� � � � � � � ' � � � � � � 
 . ' ; � � � � � � � 
 � 

 
Figure 46 - Selection of possible Contact assignments 
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 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

7 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

8 Activate the right mouse button menu over the top of the 
highlighted names and choose 7 � � %� � � 	 ' � 
 
 � 	 � �7 � � %� � � 	  

9 Click on the � 
 
 � � � �  tab in the � � � � � � � 
 � � � � � � 	  pane. 

10 Click inside the � � 	 �  field. 

11 right mouse button menu and select 3 � � � %� � � � � �  

12 In the dialogue box select the ! � � � 0  � � � � 	 �  radio button 

13 Click on � � � � � � . 

14 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

15 right mouse button menu over the top of the highlighted 
names and choose 7 � � %� � � 	 ' � 
 
 � 	 � �7 � � %� � � 	 ( 

16 Click on the QuickList selector, � � � 	 � � � �  � � � , located across 
the top of the � � � � � � � 
 � � 	 �  pane. 

17 From the pop down, choose " � � � � � � 	 . 

18 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

19 Activate the right mouse button menu over the top of the 
highlighted names and choose 7 � � %� � � 	 ' � 
 
 � 	 � �
7 � � %� � � 	 ( 

20 The last step is to make sure all our Contacts in the WorkList 
have an email address.  So, click on the 
 � � 
 � � � � � � � 	  
Action button. 

21 Activate the right mouse button menu inside the - � � � � .  
field.  Select 3 � � � %� � � � � � ' ! � � � � � 	 � �radio 
button' � � � � � � �button 

22 In the Contacts list pane, � � � � 	 � � � � � � � � � 	 	 � � �
� � � � ' � � � � � 	 � � � � ' 7 � � %� � � 	 ' 
 � � � � � � � � � � �7 � � %� � � 	 ( 
 

Assigning from a Campaign 

You can even assign names to the WorkList from a Campaign.  
Contact names can also be removed from the WorkList from either 
Targets or Respondents of a Campaign.  This helps when compiling a 
list of names for another Campaign, but you want to exclude those that 
responded to other Campaigns. 

This feature is initiated from the Campaign mode. 

What to do with a WorkList 

The WorkList now contains names of all those Contacts with email 
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 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

addresses that match the filters applied in the above steps.  As you can 
see the filters can be very complex or very simply, the end result is 
you have compiled a list of all the names for your particular purpose. 

In this example we will assign the WorkList: 

a. To a Keyword 

b. To a marketing campaign 

c. With a new field value 

d. Create an Activity Note for the selected Contacts 

Assign to a Keyword 

1 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

2 right mouse button menu over the top of the highlighted 
names and choose � � � � � � ' � � � � � � � � � � � � � 
 � � 	 � �
� � � � � 	 � 
 ( 

3 From the selection window presented, choose a Keyword to 
which to allocate the list. 

4 Click on the blue right arrow.  The Keyword will appear in 
the right hand pane labeled � � � � � 	 � 
 . 

5 Click on the � � � �  button.  The assignment is complete 

Assign to a marketing Campaign 

NOTE:  The Marketing Campaign must exist in the database. 

1 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

2 Activate the right mouse button menu over the top of the 
highlighted names and choose � � � � � � ' � � � � � � � � � � � � � 
 � �
	 � �# � � %� 	 � � � � � � � � � � � � ( 

3 From the selection window presented, choose a Campaign to 
which to allocate the list. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Figure 47 ± Select the Campaign to which the selected Contacts are to 
be assigned. 
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 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

4 Click on the � � � � � 	  button.  The assignment is complete. 

Assign a field value to a list of Companies or Contacts 

Assigning a value to a field simply means entering the same value inot 
the same field of a group of selected names.  Legrand CRM provides 
this feature in both the Company and Contact modules. 

1 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

2 Activate the right mouse button menu over the top of the 
highlighted names and choose � � � � � � ' � � � � � � �4 � � � � � � 	 � �
� � � � � 	 � 
 ( 

3 From the selection window presented, enter text into the 
appropriate fields.  In this case we will add a comment to all 
those contacts in the WorkList.  

CAREFUL!:  Selecting the � � � � � � � � � check box will erase 
all data in that field from all the highlighted Contacts! 

Also, entering a value into any field will overwrite whatever 
data already resides in that field, the only exception being the 
Comment field and using the � 
 
 � 	 � � - 9 � � 	 � � �  radio button. 

4 Select the � 
 
 � 	 �  - 9 � � 	 � � �  radio button above the 
� � � � � � 	  field. 
In the Comment field type ªAssigned to Marketing Campaign, 
14th February 2005º. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 Click on the � � � � � �  button.  The assignment is complete. 

 
 
Figure 48 ± Assigning the same value to large groups of Companies and 
Contact is easy in Legrand CRM. 

 

Careful using the 
Clear All check box! 

Every field is 
available. 
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Create an Activity Note for each Contact 

1 Inside the � � � � � � � 
 � � 	 � , right mouse button menu and choose 
� � � � � 	 � � � �.  All the names will highlight. 

2 Activate the right mouse button menu over the top of the 
highlighted names and choose � � � � � � ' � � � � 	 � � � � 	 � � � 	 � �
� � 	 � � � � � � � � � � � 	 � 
 (� �

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Notice all the selected names appear in the left pane.  From 
within the pane you can add and remove names if necessary.  
With the mouse inside the pane, use the right mouse button 
menu menu as shown in the next figure. 
 
 
 
 
 
 
 
 

3 Fill in the details required for the Activity Note. 

4 Click on the � � � �  button.  The assignment is complete and 
each Contact appearing in the left pane will have an Activity 
Note created with the details provided. 

 
Figure 49 - Creating an Activity Note for  all selected Contacts. 

 
Figure 50 - Add and remove names from the list using the r ight 
mouse button menu menu. 
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Exercise 5 ± Working with Campaigns 

Campaigns mode provides an easy to use mechanism to track events associated with 
marketing campaigns.  For example, Legrand CRM provides the facility to record 
every name to which the marketing activity has been targeted, as well as every name 
that responded to that marketing activity.  Even names of contacts not targeted can be 
recorded as a Respondent to a Campaign.  The mechanisms available in Campaign 
mode are: 

·  Record Campaign purpose and other details 

·  Record a list of Target contact names 

·  Record a list of Respondent contact names 

·  Record a list of Respondents that convert to Sales Opportunities 

·  Record Tasks to be performed on this Campaign 

·  Record notes specific to the Campaign 

·  Mail merge letters, faxes and email to Contacts appearing in the Targets 
and Respondents panes. 

Recording campaign details 
Capture the basic information of the Campaign in the details form.  All 
the fields are optional except for the Activity field. 

1 Click on the Add Campaign Action button 

 

 

 

 

 

 

 

 

 

 

 

 

 

2 Enter a description of the Campaign in the Activity field 

3 Categorise the Campaign using the Type and Category drop-
down selectors.  Remember both these drop down selectors can 
be renamed and re-populated with the appropriate values for 

 
Figure 51 ± Add Campaign entry form 
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your business. 

 

Objective tab 

Use the Objective tab to record general information about the 
Campaign and its outcome.  Use the ªObjectivesº field to record 
information about the Campaign such as how the list of Targets was 
derived and of what constitutes the Respondents list.  For example 
ªThe Target list consists of all Contacts with the Keyword ªMail ±
Newsletterº but excluding those who have ªOpted-outº of mail outsº.  
ªThe Respondent list consists of those who filled in and returned the 
enclosed response form and entered the competitionº.   

Entering text into either the Objectives field and the Notes/Outcome 
field is optional. 

However, the Objectives tab can be used to record information as to 
how the list of Targets was obtained. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 52 - Campaign Objective tab 
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Adding and removing Targets  

Target/Respondents tab 

The Target pane displays the names of the Contacts for this campaign.  
To enter names into this pane use any of the following methods: 

1 Right mouse click inside the pane and select 
 � �  � � � ! � �  or 

 � �  � # � � �. 

2 Go to the Contacts module and from within the Contact list use 
the right mouse menu and select 
 	 	 � ! � . 
 	 	 � ! � 
 � � � � � � � � 

� � 
 � � � � � � � � ! 
 � � � � � � ! � . 
See Exercise 4 ± Working with Lists for more details 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Removing Targets can only be done from within the Campaign mode 
by right mouse button menu inside the  � � ! � � 
pane. 

 

Adding and removing Respondents 
To move names into the � � 	 � � � � � � � 	  pane use any of the following 
methods: 

1 Select the name in the  � � ! � � 	  pane and click on the blue 
arrow button located between the two panes. 

2 Right click inside the � � 	 � � � � � � � 	  pane and select 
 � � 

� � 	 � � � � � � �  

 

 
Figure 53 - Campaign Detail tabs 
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NOTE: Using � 
 
 �# � � 	 � from the right mouse button menu will 
simply present a message box advising that to add multiple Contacts 
you must be in Contacts mode and use the right mouse button menu 
Assign>Assign Selected to Marketing Campaign menu. 

Remove Respondents from the list by using the right mouse button 
menu menu within the 
 � � � � � 
 � � 	  pane.  Choose 
 � � � � �  
� � � � � 	 � 
  or 
 � � � � �  � � �. 

 

Tracking Targets and Respondents 
1 Click on the � � � � � � ! �  mode button. 

2 Click on the 
 � � � � � 
 � � � � � � ! � 	  Action button. 

3 Choose the Campaign Name labeled ªGoogle web campaignº. 

4 Select the tab labeled  � � � � 	 � 2 
 � � � � � 
 � � 	 � . 

NOTICE: There are already a number of contact names in 
the Targets pane, and at least one name in the Respondents 
pane.  More names can be added to the Target list by 
switching to Contact mode and creating a list using any of the 
methods mentioned in Exercise 4 ± Working with Lists and 
then assigning them to the campaign. 

5 By holding down the Ct r l  key, select first and the last name in 
the Targets pane. 

6 Click on the blue right arrow button located between the two 
panes.  The names that were selected in the Targets pane move 
into the Respondents pane. 
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Adding Opportunities to Respondents 
During a Campaign any Respondent can be selected and be added to 
the Opportunity module (or ‘sales funnel' ).  Sales Opportunities can be 
followed from inception to completion, with as many sales process 
steps in between as defined by you under System Administration. 

1 Create a new Opportunity by activating the right mouse button 
menu on any Respondent 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
OR 

2 Create a new Opportunity by clicking on the � � � � 	 

" � � � � � # � � � �  tab and activate the right mouse button menu 
(however in this case there will be no default name and 
company selected which must be done manually by clicking on 
the � � � � � �  button). 
OR 

3 Choose � 
 
  0 � � � � 	 � � � 	 �  from the pop down menu. 

4 Alternatively, select the             menu item, � 
 
 �
0 � � � � 	 � � � 	 � (� �This�method will not automatically pick up the 
Company or Contact name, nor the currently active Campaign. 

5 The newly created Opportunity appears in the � � � � �  
0 � � � � 	 � � � 	 �  tab. 

NOTE:  When double clicking on the Sales Opportunity 
there are more fields that can be filled in. 

 
Figure 54 ± Activate the r ight mouse button menu and select Add 
Opportunity 
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Adding Tasks/Activity Notes to Campaigns 
Tasks can be added to the Campaign.  The task list is quite useful if it 
is being used as a work flow management tool.  Every Task that is 
entered to a Campaign can be easily identified as being completed or 
not by the ªCompletedº check box. 

 

 

 

 

 

 

 

Add a Task 

1 To add a Task to the current Campaign click on the 
 � � %2 � � 	 � � � 	 �  � � 	 � �  tab. 

2 In the top pane, right mouse button menu and select � 
 
 . 

3 Alternatively, select the           menu item, then � 
 
 �  � � % 

4 Using the � � � � � � � 
 � 	 �  selector choose - � � � � � 	 � � � � * � � �  

5 Once the Task is saved an email notification will be generated 
and sent to Demo Evaluator.   

6 The Task will appear in the top pane, as well as in the Task list 
(in Calendar mode) assigned to the user, Demo Evaluator. 

Add an Activity Note 

7 To add an Activity Note to the current Campaign click on the 
 � 	 � / 
 � � � � � � �  � � � � 	  tab. 

8 In the bottom pane, right mouse button menu and select � 
 
 . 

9 Once the Activity Note is saved it will appear in the bottom 
pane. 

 

Mail merging documents 
See Exercise 10 ± Mail Merge for more information on how to merge 
letters, faxes and email to Targets and Respondents.

 
Figure 55 ± Task list can be used as a work flow tool.  Note that you can 
assign Tasks per  Campaign, or  Oppor tunity or  Customer  Service issue. 
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Exercise 6 ± Working with Opportunities 
From within Opportunities mode, Legrand CRM provides a single 
location to manage and track sales opportunities from the initial 
contact to the close of the sale.  When in the Opportunities mode a 
sales team can view and track their list of current opportunities, 
administration staff can allocate opportunities to sales staff and 
management can monitor sales activities. 

A Sales department can use the Opportunities module as their central 
point of information.  For each Opportunity they can create Activity 
Notes, Calendar events and Tasks and thereby monitor progress.   

The sales cycle can be divided into Stages.  Stages can be defined 
within Legrand CRM under the Administration menu.  Each Stage 
represents a step in the sales process.  See the below for instructions on 
setting up Sales Stages. 

 

 

 

 

 

 

 

Setting the Sales Stages 
If your permissions allow, the Sales Stages can be edited, added or 
removed from the � 
 � � � � � 	 � � 	 � � � ' * � � � � � � � � � � � � � 	 � � � �  
command.  In Legrand CRM PRO and CORP Editions the command is 
� 
 � � � � � 	 � � 	 � � � ' � � � 	 � � � � 
 � � � � � 	 � � 	 � � � ' � � � 	 � � �0 � 	 � � � � ' �
� � � � � �0 � � (� � 	 � � � �  

 

 

 
Figure 56 ± Sales Stages setup screen. 



Exercise 6 ± Working with Opportunities 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

Adding new opportunities 
Adding new opportunities can be done from a number of different 
locations: 

1 Use the Add Opportunity button in the Opportunity module 

 

 

 

 

 

Managing opportunities 
 

 

 

 

 

 

 

 

2 Use the Edit>Add Opportunity menu 
 
 
 

 
Figure 57 ± Opening a new Oppor tunity from within the Oppor tunity module. 

Add Opportunity 
Action button 

 
Figure 58 ± Opening a new Oppor tunity using the Edit menu. 

Using the Edit menu. 
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3 When in the Company module use the right mouse menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4 Or, again, when in Company module use the right mouse menu 
within the Opportunities tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 59 ± Adding an Oppor tunity to Jay Jones at ABC Games using the r ight 
mouse menu. 

Select Company 

Select Contact 

Open right mouse 
menu 

 
Figure 60 ± Adding an Oppor tunity to Jay Jones at ABC Games using the r ight mouse 
menu from within the Oppor tunities tab. 

Select Company 

Select Contact 

Select Opportunities 
tab 

Open right mouse 
menu (when cursor is 
inside the list window) 
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5 When in Contacts module, click on the blue Contact 
Information title bar and use the menu that is presented. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6 When in Contacts module, click on the Opportunities tab and 
use the right mouse menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 61 ± Adding an Oppor tunity to Jay Jones at ABC Games using the title bar  
menu from within the Contacts module. 

Select Contact Click inside blue title 
bar 

Select 
Add Opportunity 

 
Figure 62 ± Adding an Oppor tunity to Jay Jones at ABC Games using the r ight mouse 
menu from within the Contacts module Opportunities tab. 

Select Contact Click 
Opportunities tab 

Select Add from right 
mouse menu 
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1 Click on " � � � � � # � � � � � 	  navigation button 

2 Using the � � � � � � 	 �# � � � � � �  QuickList selector, check the 
� � � � � � 	 �# � � � � � �  check box and choose * � � � � / � � �  from 
the pop down selector. 

3 The Opportunities list is initially sorted in the order of the user-
defined sales stages.  If the sorting is altered when double 
clicking on the column title and you wish to have it sorted by 
sales stage once again, simply click on 
 � � 
" � � � � � # � � � � � 	 , 
� � 
" � � � � � # � � � � � 	  or do step 2 again. 

4 Select an Opportunity that is in its Initial Stage. 

5 Click on the � � 	 � � �  button located in the top right of the 
information pane. 

NOTICE:  An opportunity can Progress or Regress to the 
next stage. 

6 Select " � � � � � � � � 	 � � � � 9 	 � � 	 � � �   

NOTICE: The Opportunity now moves into the Proposal 
stage and moves down the list. 

In the 
 � � � � � � � 
 � � � � 	  tab, an Activity Note is automatically 
added recording the change in stage.  This automatic Activity 
Note feature can be turned off under System Options.   
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Measuring results 
1 Click on 
 � � � � 	 � 
Action button 

2 Check the � � � � � � 	 �# � � � � � �  check box and choose * � � � �
/ � � �  from the pop down selector. 

3 Using the radio buttons at the bottom of the screen you can 
change whether the chart reports results in dollars or in 
quantity. 

4 You can export the chart into Word using the buttons at the 
bottom of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reviewing Closed Opportunities 
There are two ways to review closed opportunities: 

1. In the list view click on the Closed Opportunities radio button 

2. In the graphical window activated using the Analyse button, 
click on the Closed Opportunities radio button. 

 
 

 
Figure 63 - Opportunity analysis screen. 
 
 

View graph of Open or 
Closed Opportunities 

View graph by both value 
and by the number of 
Opportunities 

Create a bitmap image and 
insert into a Word document 
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Exercise 7 ± Working with your Calendar 

Where can I add an appointment? 
Appointments can be added whilst in the following modes: 

NOTE:  When adding appointments in each mode, the appointment 
entry form will automatically fill in details differently. 

·  Company mode, right mouse button menu on Contact name in 
� � � � � � � 	  tab.  The entry form will automatically fill in the 
Contact and Company details in the 7 �	 �  fields.  The default date 
and time is today' s date between 9am and 10am. 

·  Contact mode, 
 � � 
 
 � � � � � � � � � �  Action button.  The entry 
form will automatically fill in the Contact and Company details in 
the 7 �	 �  fields.  The default date and time is today' s date between 
9am and 10am. 

·  Contact mode, by selecting the Appointment tab and activating the 
right mouse button menu.  Select Add from the menu. 

·  Campaign mode, when an Opportunity is opened, � � � � � � � � 

( � � � � 	  tab, right mouse button menu and select � 
 
 .  The entry 
form will automatically fill in the Opportunity details in the 
0 � � � � 	 � � � 	 �  field.  The default date and time is today' s date 
between 10am and 11am. 

·  Opportunity mode, � � � � � � � � 
 ( � � � � 	  tab, right mouse button 
menu and select � 
 
 .  The entry form will automatically fill in the 
Opportunity details in the 0 � � � � 	 � � � 	 �  field.  The default date 
and time is today' s date between 9am and 10am. 

·  Calendar mode, whilst in any of the following Calendar view 
modes: 

o Day View 

o 5-Day Week 

o 7-Day Week 

o Month View 

 

Drag the cursor over the number of vertical bars that represent the 
duration of the calendar event.  For example, if the meeting is one hour 
long then drag the cursor over 2 bars, then activate the right mouse 
button menu and select Add Calendar Event. 

Using Calendar views 
1 Click on the 0 %& � � 
 � � � � 
Action button. 

2 Using the selector above the calendar, labeled 4 �� � � � � � � � 
 � � �
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- � � � 	 � � � � � , select - � � � � � 	 � � � � * � � � . 

3 To the left, in between the blue left and right buttons, click on 
the word  � 
 � � .  The Calendar will move the 5 day view to 
display today' s date. 

NOTICE:  Today' s date is displayed with a preceding (* ) 
symbol. 

4 Click on any date in view. 

5 Drag the cursor over the time 9:00 to 10:30.  Three bars should 
be highlighted. 

6 right mouse button menu and select � 
 
 � � � � � � � 	 � � � 	 .  An 
Appointment entry form will be presented. 

NOTICE:  Automatically the entry form is filled in with 
information such as:  

·  the currently logged on user' s name in the 
� � � � � � � 
 � 	 �  selector 

·  date  

·  Start Time and End Time as determined by  
 the number of bars highlighted 

7 Using the � � � � � � � 
 � 	 �  selector, choose - � � � � � 	 � � � � * � � � . 

8 In the � � � � � � �  field type in ªMeeting with Richardº. 

9 Select the  � � �  drop-down selector and choose � � 	 � �
� � � 	 � � � . 

10 Click on the 7 � � �  drop-down selector and choose tomorrow' s 
date. 

11 Click on the 
 � � � � 
 � �  check box.  The adjacent time interval 
drop-down selector is now available for use. 

12 Select . � � � � � . 

13 Using the � 
 
  button in the 0 	 � � � � " � � 	 � � � � � � 	 �  section, find 
Richard Davenport, select his name and click on � � � � � 	 .  
Richard Davenport' s name will now appear in the 0 	 � � � �
" � � 	 � � � � � � 	 �  window. 

14 Use the 
 � � � � � � � �  button to create on-going appointments for 
the same event.   

15 Click on � � � � .   
An email will be automatically generated and sent to Demo 
Evaluator, provided the system has been configured to do so.  
In this particular case, the user Demo Evaluator does not have 
an email address configured in System Administration so you 
will be prompted to manually enter the email address. 
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Exercise 8 ± Working in MS Outlook mode 

Legrand CRM v4.0 provides integration with MS Outlook 2000 and above.  
Integration includes importing email directly from Outlook to Legrand CRM.  Email 
imported into Legrand CRM are stored as Activity Notes within the Contact record.   

Transferring email into Legrand CRM is performed manually.  Legrand CRM has 
been purposely designed this way so that only selected information is stored within 
the database. 

Any email, incoming, outgoing or other email stored in Outlook can be transferred 
and retained in Legrand CRM as an Activity Note with a Type of either Email In or 
Email Out depending on whether the email was received or sent from your Outlook 
session. 

Once email is transferred into Legrand CRM a chain icon will be displayed against 
the email indicating that transfer has occurred. 

Viewing your Outlook folders within Legrand CRM 
1 Click on the � � 
" # � � � � �  mode button. 

2 Expand the " � � � � � � � �&� � 
 � � �  tree. 

3 Click on ! � � � 9 .  All the items in your Outlook Inbox will be 
displayed. 

4 Click on the other folders.  If any email exists in those folders 
they will be displayed in the top pane. 

Transferring Outlook items into Legrand CRM 
Any items in Outlook can be transferred and recorded in 
Legrand CRM, including Tasks, Contacts, Sent and Deleted items. 

5 Whilst in � � 
" # � � � � �  mode, in any folder, right mouse 
button menu on any email message and select 
 � � � � � � � � � � � � � 	 � 
 � � � � � �0 � 	 � � � % 

Legrand CRM will search for the Contact name using the sender' s 
email address as a filter.   

NOTE: If the Contact does not exist then a message box will appear 
with an option to assign the email message to another Contact or, 
create a new Contact and assign it to that newly created Contact. 

If the Contact already exists then an Activity Note will be created and 
assigned with the Type - � � � � � ! � �or� - � � � � �0 � 	 �depending on 
whether the email was sent or received by your email system. 

6 To find the newly added email, switch to � � � � � � � �  mode and 
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click on the 
 � � � � � � � 
 � � 	 �  Action button. 

7 Click on the � �  ! 4 !  8 � � � � 	 � � � � 	 � � � �  button at the top of the 
screen 

8 In the dialogue box the default date range is 2 days prior to 
today' s date so just click on the - 9 � � � 	 �  button. 
The Activity Note will appear dated the same as the email and 
with a  � � � �of - � � � � � ! � . 
The same Activity Note will appear in Contact mode, and in 
Company mode provided the Contact is attached to a 
Company. 
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Exercise 9 ± Working in Cust.Service mode 

NOTE: Cust.Service mode is an option in Legrand CRM PRO Edition and Legrand 
CRM CORP Edition. 

When first switching into the � � � 	 (� � � � � � � �module the default view is currently 
0 � � � � � � � � � � � � � � � � � � , as determined by the radio button selection above the 
� # 	 � *� � � � � � � 
 � � 	 �  pane. 

 

 

Adding a new Cust.Service item 
1 In the � # 	 � � � � � 
 � � � � � � � 
+	 	 # �  information pane, click on 

the � � �  button located on the blue title bar.  Once the details 
have been filled in and the new item saved it will appear in the 
� # 	 � *� � � � � � � 
 � � 	 �  pane. 

NOTE:  The � # 	 � *� � � � � � � 
 � � 	 � 
pane can be resized by 
dragging the right edge with the mouse cursor. 

You may need to toggle the maximize/minimize window 
button to re-centre all the fields. 

2 Using the tabs across the bottom of the screen the service issue 
can be managed ensuring all issues are addressed in a timely 

i  

 
Figure 64 - Customer  Service module 

View Open or Closed issues 

View just issues assigned to 
you (the currently logged in 
User) 

Reassign issues to other 
staff members, thus using 
this module as a Issue 
Routing tool 

Issue logged by Contact and 
Company. 
This issue will be displayed 
when either is selected in 
either module 
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manner.  Click on the & � 	 � � � � � � � �  tab. 

3 Type in ªCustomer requested 100 additional CDs be sentº 

4 Click on the � � 	 � � � 	 �  tab. 

5 Type in ªCustomer advised there is 24hr response and should 
expect CDs to arrive in 2 working days.º 

6 Click on 
 � � � � � � � 
 � � � � 	  tab.  There should be one Activity 
Note entry created when the item was created. 

7 right mouse button menu and select � 
 
 . 

8 Enter the  � � �  of note 

9 Enter a brief description in the � � � � � � �  field 

10 Enter detailed information in the � � 	 � �  field 
 

Assigning a Cust.Service issue 
Assigning a Customer Service issue to a staff member is performed 
using the � � � � � � � 
 � 	 �  pop down selector.  Only the names of Staff 
configured in User Accounts will appear for selection. 

1 First go into User Account under the Administration menu and 
enter an email address into each of the User names.  Type in 
your own company email address in the name * � � � � / � � �  and 
* � � � � - � � � � � 	 � �  so as to demonstrate this next step. 

2 Click on � � � � � � � 
 � 	 �  pop down selector. 

3 Choose * � � � � - � � � � � 	 � � .  An email message box will be 
displayed.   

4 Notice that there is no � � � 
  button available.  Make a simple 
edit to the email, such as adding a space to the end of the 
message, and a � � � 
  button will become visible. 

5 Click on the � � � 
  button. 
If no email address has been entered for that User then an email 
will still be created with the  � <�field blank. 
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Exercise 10 ± Mail Merge 

Merged letters, faxes and email can be sent to any number of selected Contacts from 
within Contacts mode.   

Merging of data into a letter or email is also available from within Company mode.  
A selected Contact name has the same functionality available however the 
fundamental difference is that only one Contact at a time can be merged.  Obviously, 
large numbers of merged documents would be performed in Contacts mode. 

Personalising an email is when the recipient' s email address appears in the  �  field.  
When using HTML templates you can both personalise and merge an email. 

Letters and Faxes 

Merging a single Contact in Contact mode 

NOTE:  Fax merging requires Symantec' s WinFaxPro to be installed 
and configured. 

1 Click on � � � � � � � 	  mode button. 

2 From within the � � � � � � � 	 
 � � 	 �  pane select a name.   

3 right mouse button menu over the highlighted name and select 
# � � � �# � � � � � � � � � � 	 � 
 .  From the form presented a mail 
merge can be performed for both printed letters and faxs.   

4 From within the Letter Templates window select - � = � � � � �
� � 	 	 � � . 

5 Click on � � � � 	 � � � � 	 � � � 	 � � � � 	 �  check box. 

6 In the field � � 	 � � � � � � � � � : type ªInitial Enquiry letter re: 
new softwareº 

7 Click on the � � � � � � � 	 	 � � � * � � � � � � 	 � � � 	 � � 	 � � � � � 	 � � � 	 � �
� � 	 �  button. 

8 In the � � 	 	 � � �&� � � � � � � �  field type ªInitial Enquiry Letterº 

9 Click on " � � � 	 � " � � � � � �  button.  Any of the print or fax 
buttons will create the Activity Note with a copy of the 
document attached.  Selecting a " � � � 	 � " � � � � � �  or &� 9�
" � � � � � �  button will open and display the document.  You can 
then elect to print from there. 

NOTE:  When choosing " � � � 	 � " � � � � � �  or &� 9�" � � � � � �  
buttons with the � � � � 	 � � � � 	 � � � 	 � � � � 	 �  box checked will 
create an Activity Note. 

Merging to a single Contact in Company mode 

NOTE:  Fax merging requires Symantec' s WinFaxPro to be 

i  

i  

i  
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installed and configured. 

1 Click on � � � � � � �  mode button. 

2 Click on � � � � � � � �  tab  

3 From within the � � � � � � � 	 
 � � � � � � pane select a name.   

4 right mouse button menu over the highlighted name and select 
# � � � �# � � � � .   

NOTE:  Any Mail Merge function within Legrand CRM 
provides the ability to record the merge event as an Activity 
Note.  This is the fundamental difference between Mail 
Merge and Print selections on the right mouse button menu 
menu. 

 

 

 

 

 

 

 

 

 

 

 

 

Merging selected Contacts 

When merging for more than one Contact the steps are identical as 
listed above in Merging a single Contact in Contact mode however the 
� � 	 	 � � �&� � � � � � � �  field is not made available.  This is because when 
multiple letters are merged, only one example of that letter is stored 
and is referenced by all Activity Notes for all Contacts in the merge 
list rather than attaching a letter to every Activity Note. 

Merging to a complete list 

Merging to a complete list of Contacts can be performed in both 
Contacts mode as well as Campaign mode. 

 

Merge events cannot be automatically  
recorded as Activity Notes:  use 
Assign>Activity Notes instead 

Merge events can be recorded as Activity 
Notes 

i  
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Contacts mode 

1 Create a filtered list of Contacts using QuickList or 
QuickSearch. 

2 From within the � � � � � � � 	 
 � � 	 �  pane right mouse button menu 
and choose � � � � � 	 � � � �.   

3 right mouse button menu over the highlighted names and select 
# � � � �# � � � � � � � � � � 	 � 
 .  From the form presented a mail 
merge can be performed for both printed letters and faxs.   

4 As with the above section Merging selected Contacts, 
� � 	 	 � � �&� � � � � � � �  field is not available. 

Email 
Legrand CRM provides facility to merge simple text email as well as 
HTML formatted email.  If the HTML email contains images or 
pictures, then those image files can also be included in the HTML 
email and sent as a complete package. 

In both the Text email entry box and the HTML email entry box a file 
(of any type eg: .doc, .xls, .bmp etc.) can be attached and Activity 
Notes created to record the event against the Contact' s name. 

Text – non personalised 

Non-personalised means that the recipient' s email address will not 
appear in the  � �field.  These email are sent as one email addressed to 
many Contacts. 

1 Select a single contact or multiple contacts from within the 
� � � � � � � 	 
 � � 	 �  pane. 

2 right mouse button menu and select - � � � � ' � � � 
 �  � 9 	 � � � � � � �
	 � � � � � � � 	 � 
  
An email dialogue box will open with the : � �  field greyed-out 
and the words multiple contacts …inside. 

3 Attach documents if required using the � 	 	 � � � �&� � �  button. 

4 Create an Activity Note for each Contact using the � � � � 	 � �
� � 	 � � � 	 � � � � 	 � �drop-down selection box if necessary to record 
this mail merge event. If selected, an Activity Note will be 
created for each Contact with recording either the Subject of 
the mail merge, or with both Subject and email content. 

HTML – non personalised 

Depending on how your copy of Legrand CRM email is set up email 
with embedded images may be merged (see under 
� 
 � � � � � 	 � � 	 � � � ' / � � � �0 � 	 � � � � ' - � � � � � � � � 	 � � ).  Merging 
HTML-formatted mail is essentially the same as sending Text email 
however the difference lies in the variety of fonts and formatting that 
can be applied to the text.  Pictures (.jpg and .gif files) may be added 
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 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

to your HTML email as well. 

1 Select a single contact or multiple contacts from within the 
� � � � � � � 	 
 � � 	 �  pane. 

2 right mouse button menu and select - � � � � ' � � � 
 � �  # � �
� � � � � � 	 � � � � � � � 	 � 
  
An email dialogue box will open with the : � �  field greyed-out 
and the words multiple contacts …inside. 

3 Format text and images using standard Windows-style toolbar 
and menu functions. 

4 Attach documents if required using the � 	 	 � � � �&� � �  button. 

5 Create an Activity Note for each Contact using the � � � � 	 � �
� � 	 � � � 	 � � � � 	 � �drop-down selection box if necessary to record 
this mail merge event. 

NOTE: All Contacts in the selected list MUST have an email 
address.  An error message will advise of the first name 
without an email address.  Using a combination of the 
WorkList and, QuickSearch on the email field, an accurate 
list of Contact names with an email address is easily 
compiled. 

Personalised HTML email 

NOTE: This feature is available in Legrand CRM PRO edition and 
Legrand CRM CORP Editions only. 

Personalised email refers to email that is sent directly to the recipient 
and the recipient' s email address appears in the  �  field.  In 
Legrand CRM, HTML email templates can contain field codes, just 
like Word templates.  Using a HTML template your email message 
can contain information specific to each person being emailed, just 
like merging to a Word document! 

1 Format the HTML document using a HTML editing tool. 
Using the same field codes as in a Word template, substitute 
words with field codes where personalization is required.  Eg. 
When referring to your Contact you would have ªDear 
[#First Name#]º in your HTML template.  An example HTML 
file exists under the directory: 
\ Legr andCRM\ PRODEMODATA\ eTempl at es\ Si mpl e_t est . ht m. 
See Exercise 11 ± Creating merge templates for detailed 
information. 

NOTE:  When preparing an HTML template there is no 
button provided to assist with inserting Legrand CRM field 
codes, however, you can use a blank Word document together 
with the � � � � � � 
 &� � � 
 � �button to paste the codes into Word 

i  
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 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

and then copy them into your HTML template. 

 

IMAGES: In Legrand CRM a personalised HTML email can 
contain embedded images eliminating the reliance for the 
recipient to be connected to the web or for your web site to 
contain all the image files. 

To use this feature your installation of Legrand CRM must be 
configured under: 
� 
 � � � � � 	 � � 	 � � � ' / � � � �0 � 	 � � � � ' - � � � � � � � � 	 � � ' �
/ � � � � * 0 �>7 � � 
 � � � � , ? ? ? �@�; " � � � � � A(�

See Exercise 11 ± Creating merge templates for more detailed 
information. 

2 Make sure your list of Contact names have an email address by 
using a combination of the WorkList and, QuickSearch on the 
email field using the � � � � 0  � � � � 	 � �radio button or you can 
use � � � 	 � � � �  ª@º. 

3 Select a single contact or multiple contacts from within the 
� � � � � � � 	 
 � � 	 �  pane. 

4 right mouse button menu and select - � � � � ' � � � 
 �
" � � � � � � � � � � 
 � � � � � � � 	 � � � � � � � 	 � 
  
An Email Mail Merge dialogue box will open with the list of 
target Contact names in the left pane. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: Use the right mouse button menu button to add and 
remove Contact names. 

5 Double click on the - � � � � column title.  You can quickly see 
which names do not have an email address in the left column.  

 
Figure 65 - Prepar ing to merge an eTemplate 
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Unless all names have an email address, this function cannot be 
completed.  

6 Using the ellipses () ) button, find and select the HTML 
template for this mailout. 

7 Use the " � � � � � �  button to check the HTML content is correct.  
The HTML document will open in your web browser. 

8 Type a � � � 1� � 	  for this email mail merge 

9 Attach documents if required using the � 	 	 � � � �&� � �  button. 

10 Create an Activity Note for each Contact using the 
� � � � 	 � � � � 	 � � � 	 � � � � 	 � �drop-down selection box if necessary 
to record this mail merge event. 

NOTE: All Contacts in the selected list MUST have an email 
address.  An error message will advise of the first name in the 
list without an email address. 

 

Labels 
Although there are 3 supported labels formats, each of these templates 
can be altered to produce labels for your specific requirement.   

To change the label template simply go to the directory containing 
Legrand CRM, usually \ Legr andCRM\ Mai l Mer ge.  Inside that folder 
are the word documents that can be reconfigured for your purposes, 
however the names of those documents should not be changed.  The 
default label formats supported are: 

o Avery 7160 

o Avery 7161 

o Avery DL24 

Each of these formats can be changed to suit your label stock. 

NOTE: The right button menu in Contacts module does not 
change. 

 

Envelopes 
Although there are only 2 supported envelopes each of the templates 
are customisable for your particular requirement. 

i  
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 � � 
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To change the envelope template simply go to the directory containing 
Legrand CRM, usually \ Legr andCRM\ Mai l Mer ge.  Inside that folder 
are the word documents that can be reconfigured for your purposes, 
however the names of those documents should not be changed. 

1 Select a Contact name in the � � � � � � � 
 � � 	 �  pane. 

2 right mouse button menu and select " � � � 	 � - � � � � � � �  for 
� � � � � 	 � 
 ' - � � � � � � � � � 	 � � � � . . 
Word will create a document merged with the selected 
Contact' s details in envelope format.  From here you may elect 
to print the envelope. 

3 To print envelopes for an entire list of Contacts first make sure 
Excel does not have the labels.xls file open.  If it is open, close 
it.  First, let' s filter the Contact list so it shows just our 
Customers. 

4 Using the QuickList � � � 	 � � � �  � � � , pop down the selector and 
choose � � � 	 � � � � . 

5 right mouse button menu on the � � � � � � � 
 � � 	 �  and select 
" � � � 	 � - � � � � � � � � � � �  � � � 	 ' - � � � � � � � � � 	 � � � � . . 
Excel will open and create a file used to mail merge with 
Word.  Word will create a single document containing all the 
merged envelopes for the list of Contacts as displayed and 
filtered in the � � � � � � � 	 
 � � 	 �  pane. 
From Word you can elect to print the envelopes. 
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Campaign mode 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Letters and faxs 

In Campaign mode, Contacts found in either Targets or Respondents 
panes can be merged into letters or faxs. 

1 Either select a group of Contact names in either pane and 
choose # � �� �# � � � � � � � � � � 	 � 
  from the right mouse button 
menu menu, or choose # � � � �# � � � � � � � � from the right mouse 
button menu menu. 

Email 

Whilst in Campaign mode, email merging is limited to: 

o Personalised HTML email to a single recipient 

o non-personalised HTML email to more than one recipient 

At this point in time, personalized HTML template email is not 
available whilst in Campaign mode.  These features can only be 
initiated from within Contact mode by using the Add to Worklist 
function. 

 
 

 
 

Target right mouse button 
menu menu  

Respondents right mouse 
button menu menu 

Under discussion 
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Exercise 11 ± Creating merge templates 

Legrand CRM provides flexibility in creating merged Word documents, faxes and 
HTML email.  Using templates, your customers can be referred directly by their 
names and other information relevant to them as stored in the database. 

Introduction 
Merge templates are created for use by a specific mode.  For example, 
you may have a template that you want to merge when in Company 
mode.  Another template may be required for merging when in Contact 
mode (this by far is the most common mode for letter and 
eTemplates).  Typical examples here are templates for Welcome 
letters, Fax template, Thank you letter, newsletter and quotation 
template. 

Merge templates consist of the text and picture information you are 
sending to your customer/clients, plus any fieldcodes that are required 
in the letter.  Each of the templates can only extract data from the 
mode in which it is designed (eg Contact mode) and data from an 
linked mode (when in Contact mode you can insert fieldcodes from 
Company mode).     

Fieldcodes 
Legrand CRM uses identifiers for each field that is to be replaced by 
data.  These fieldcodes are inserted into a Word template or a HTML 
eTemplate.  The identifiers are [# at the start of the field code followed 
by #] at the end.  For example, to insert the Contact' s first name into a 
letter template the fieldcode would be [#First Name#].  When the 
template was being merged, each time this fieldcode is detected the 
Contact' s first name would replace it. 

Screen labels that have been renamed 
Most users of Legrand CRM will have renamed some names on the 
screen.  Changing the screen labels does not change the fieldcode 
names.  This means that if you have created a template with fieldcodes 
for / � � � .  field, for example, and you rename the screen label for 
/ � � � .  to be - � � � � � � � � �then your template will still merge. 

Remember that your fieldcode will be unchanged regardless of the 
screen label. 

 

 

 

 

 

 
Figure 67 - Default field labels 
 

 
Figure 66 - User  defined field label 
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Document merging relationships 
In Legrand CRM fields can be merged from linked modes as well.  In 
Figure 38 you will notice that there are fieldcodes from both 
Companies and Contacts.   

Currently Legrand CRM allows merge templates to be created for  

o Companies 

o With link to Contacts 

o Contacts 

o With link to Company information 

o Notes 

o With links to Companies 

o Contact 

o Opportunities 

 
Figure 68 - Fieldcodes in a Word template 
 

 
Figure 69 - Fieldcodes replaced with data in a completed merge. 
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 ��� � � �� �� � �� � � � � � � �   � � � � �� � �

o Schedule (Calendar) 

o With links to Contacts 

o Companies  

o Opportunities 

o Opportunities 

o With links to Companies 

o Campaigns 

o Tasks 

o With links to Contacts 

o Marketing 

o Opportunities 

o Support 

o With links to Companies 

o Contacts 

o UserList 

 

MS Word templates 
You can create your own personal Word document that can be used 
over and over again for as many different Contacts as you wish, each 
one merged with the Contact' s information. 

1 Click on � 
 � � � � � 	 � � 	 � � � �menu item. 

2 Select B7 � � 
 C� 	 � � � � � 	 � � . 

3 In the Letter Template Maintenance window, click on the 
� � 	 � � � � �  pop down selector and choose � � � 	 � � 	 � . 

4 Click on the � 
 
  button 

5 Type into the � � � �  field ªMy personal letterº 

6 Click OK.  A Word document will open with a name of 
My per sonal  l et t er _xxxxxx. doc .  Inside this document 
insert the field codes that Legrand CRM will replace with 
values during the merge.   

7 Inside Word click on the � � � � � � 
 &� � � 
 �  macro button.   

HELP: If the � � � � � � 
 &� � � 
 �  button is not visible inside 
Word on the toolbar then right mouse button menu in the 
toolbar area and select � � � � � � 
 � 
 #  from the pop up menu. 

8 Select � � � 	 � � 	 � ' 0 �   

9 In the Contacts Table you will see all the fields that can be 

i  
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inserted into the template.  You can insert the same field as 
many times as required.  E.g. if you want the first name to 
appear in the body of the text then simply insert 
DE &�� � 	 � � � � � E F using this dialogue box.   

HINT:  Field codes are simply text that Legrand CRM 
recognizes and replaces with the actual field value.  So, 
simply copy and paste the field code when you want to use it 
elsewhere in your template. 

10 Select DE &�� � 	 � � � � � E F and then the Insert button.  The field 
code is inserted at the cursor location. 
Select G� � � %�� � � � � � � � � '  then the 0 �  button.  You now 
have access to all the Company information belonging to this 
Contact.  Of course, only if the Contact is linked to a Company 
will Company information be inserted. 

INFORMATION:  If your Contact is not linked to a 
Company then you can use the check box labeled 
/ � � � 	 � � � � � � � � � � � � � � 
 
 � � � �  located on the Contact' s 
� � � � 	 � �  tab and the information contained therein will be 
used instead of G� �� %� � � � � � � � � � '  address equivalent. 

HTML templates for personalized email 
HTML templates can be created using any HTML editor such as 
Dreamweaver.  Using the same field codes as used in Word templates, 
simply substitute text in your HTML template with those same field 
codes. 

For example, below is HTML code used in the sample HTML 
template found in \ Legr andCRM\ PRODEMODATA\ eTempl at es  with 
additional � � � 	 � � � � �  field added. 
<P><b>Dear  [ #Fi r st  Name#] </ b> <b>[ #Last  Name#] </ b>, </ P> 

<P>Look at  t hi s  message i n t ext  mode t o see t he HTML t ags t hat  ar e used 
and t he st y l e sheet  t ags. </ P> 

<P> 

 <span c l ass=' openi ngheader ' >I n t hi s  i ssue: </ span> </ P> 

 

 

 

 

 

 

 

  
Figure 70 - Creating an eTemplate 
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Store your HTML templates in the eTemplates directory. 

1 To open Legrand CRM' s simple HTML editor use  the menu 
command � 
 � � � � � 	 � � 	 � � � ' �  � � � � � 	 � �  

2 Open an eTemplate,  � � � � � 	 � � ' 0 � � � � 	 � � � � � 	 �  

3 Select the HTML template and use this editor to make changes 
to the text of the email.  Use your more sophisticated HTML 
editing tool to make changes to graphics, lines and tables. 

 

Adding images to your HTML template 

Normally, when using Outlook to send HTML email with images, 
those images are not embedded with the email message but referenced 
to a web site.  This makes the email file size quite small however it 
relies 1.. on the image being available on a web site and 2.. your 
Outlook session being connected to the web. 

With Legrand CRM is configured to use CDO 
(� 
 � � � � � 	 � � 	 � � � ' / � � � � � � 	 � � � � ), email images inserted into an 
HTML template will be sent as an attachment with the email thus 
eliminating the need for the recipient to be connected to the web. 

1 To insert an image into your HTML template, use your 
favourite HTML editing tool.   

2 Insert images as you would normally do when creating a 
HTML document. 

IMPORTANT:  Make sure the HTML template references 
the image explicitly.  For example, here is a sample line of 
HTML 
<i mg sr c=" f i l e: / / d: \ Legr andCRM\ eTempl at es\ l ogowhi t e- cr m. gi f "  
wi dt h=" 172"  hei ght =" 75" > 

Notice that after f i l e: / /  the location of the image to be 
embedded is explicitly stated. 

3 Save the HTML template into the eTemplates directory.  The 
template is now ready to be used with the 
- � � � � ' � � � 
 � " � � � � � � � � � � 
 � � � � � � � 	 � � � � � � � 	 � 
 �function. 
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Exercise 12 ± Reports  

Legrand CRM reports are provided as pre-formatted reports and as user-modifiable. 
The pre-formatted reports cannot be changed. 

Pre-formatted, unchangeable 

Company Print List 

1 right mouse button menu on the highlighted company name in 
the � � � � � � � 
 � � 	 �  pane. 

2 Select " � � � 	 � � � � 	  

3 A preformatted document will be presented in a print preview 
screen.  This report does not require Word to be installed. 

The fields in the report are: 

� � � � � � � � � � � � � � � 	 � � � 	 � � 
 
 � � � � � � � � 	 � � � � 	 � 	 � � � � � 
 � � �
� � � � 	 � � � � " � � � � � �&� 9� �  � � � (�

Sorted by:  

Company Export List 

1 right mouse button menu on the highlighted company name in 
the Company list pane. 

2 Select - 9� � � 	 � � � � 	 (� �This creates an Excel spreadsheet with 
most of the fields exported. 

 

Contacts Print List 

1 right mouse button menu on the highlighted company name in 
the � � � � � � � 
 � � 	 �  pane. 

2 Select " � � � 	 ' " � � � 	 � � � � 	  

3 A preformatted document will be presented in a print preview 
screen.  This report does not require Word to be installed. 

The fields in the report are: 

� � � 	 � � 	 � � � � � � � � � � � � � � � � � � � � � " � � 	 � � � � 
 
 � � � � � � � � 	 � � �
� 	 � 	 � � � � � 
 � � � � � � � 	 � � � � * � � � � 	 � " � � � � � � � � � � � � � � " � � � � (�

Report is sorted as displayed in the � � � � � � � 
 � � 	 �  pane. 

Contacts Export List 

1 right mouse button menu on the highlighted company name in 
the � � � � � � � 
 � � 	 �  pane. 

2 Select - 9� � � 	 � � � � 	 (� �A dialogue box will open presenting you 

i  

i  



Exercise 12 ± Reports  

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

with check boxes (see below).  Check each box for each field 
required in the Excel report output.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 
Figure 72 - Expor t Contacts to Excel.  Field selections. 



Exercise 13 ± Personalising Legrand CRM 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

Exercise 13 ± Personalising Legrand CRM 

Legrand CRM provides a cost effective CRM solution to most businesses that depend 
on information to be shared amongst internal and mobile users.  Legrand CRM has 
been designed to be extremely user-friendly and productive from day one.  With this 
in mind, customization features are minimal, rich, however, in personalization 
features. 

Personalising Legrand CRM for your business using familiar industry terminology 
adds to the ease of use. 

Common across all editions 

Renaming Company and Contact module names 

When changing module names, Legrand CRM must be closed and 
restarted for changes to take full effect. 

 

 

 

 

 

 

 

 

STD edition 

1 To redefine Company and Contact module names use 
� 
 � � � � � 	 � � 	 � � � ' � � � � � � � � � 	 � � � �0 � 	 � � � � ' � � 	 � � � 

� � � � � � ! 	 ' # � 
 � � � � � � � � � �

PRO and CORP editions 

1 To redefine Company and Contact module names use 
� 
 � � � � � 	 � � 	 � � � ' � � � 	 � � � � 
 � � � � � 	 � � 	 � � � ' � � � 	 � � �
0 � 	 � � � � ' # � 
 � � � � � � � � �  

Re-labeling Field names and Tab names 

Redefining field names and tab names is centrally controlled.  Once 
field names have been changed, restart Legrand CRM. 

STD edition 

1 To redefine field names and tab names use 
� 
 � � � � � 	 � � 	 � � � ' � � � � � � � � � � � � �  

PRO and CORP Editions 

 
Figure 73 ± Renaming modules 
 



Exercise 13 ± Personalising Legrand CRM 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

2 To redefine field names and tab names use 
� 
 � � � � � 	 � � 	 � � � ' � � � 	 � � � � 
 � � � � � 	 � � 	 � � � ' � � � � � � � � � � � � �  

Setting Calendar colours 

Each user registered in the User Account set up screen can is given a 
separate colour.  The colour setting for that user is displayed in the 
Calendar mode of Legrand CRM when that user has set a Calendar 
event. 

STD edition 

1 To set up a user' s colour setting use the 
� 
 � � � � � 	 � � 	 � � � ' / � � � � � � � � � � 	 � � � � � � � 	
 �  

PRO and CORP editions 

2 To set up a user' s colour setting use the 
� 
 � � � � � 	 � � 	 � � � ' � � � 	 � � � � 
 � � � � � 	 � � 	 � � � ' / � � � �
� � � � � � 	 �  

Define Sales Stages 
 

 

 

 

 

 

 

 

 

 

 

 

STD edition 

1 To redefine Sales Stages use � 
 � � � � � 	 � � 	 � � � ' * � � � � � � � � � � � �
� 	 � � � �  

PRO and CORP editions 

1 To redefine Sales Stages use � 
 � � � � � 	 � � 	 � � � ' � � � 	 � � �
� 
 � � � � � 	 � � 	 � � � ' * � � � � � � � � � � � � � 	 � � � �  

 

 
Figure 74 - Defining sales stages 
 



 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

STD Edition PRO/CORP Edition 

Exercise 14 - Menu functions 

 

 

 

Menu functions will produce the same pop up menus regardless of which mode 
Legrand CRM is currently in.  Below are screen shots and information on each menu 
function pop up menus. 

File 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 
 

 

 
 

 
Figure 75 - Legrand CRM menu 
 

 

 
 



 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

New 

Create a new Legrand CRM datafile using the � � � � 	 � � � � � � � �
* � 	 � � � � � �wizard. 

Open 

Open an existing Legrand CRM datafile. 

Print Setup 

Opens the Windows printer setup screen. 

Synchronisation 

All versions of Legrand CRM can be synchronized with a master 
database.  STD edition can only synchronise the entire database 
between the client and master databases, however, PRO and CORP 
editions provide both complete and restricted synchronization.   

Import 

Import data from a delimited file into Contacts, Contacts and 
Companies, Companies, assign Keywords to Contacts, assign 
Keywords to Companies. 

Accounting data can be imported from a text file, or directly from 
various accounting packages.  Imported data is displayed in 
� � � � � � �  mode in the 
 � � � # � � � � ! 
tab. 

Exit 

Exit and close your Legrand CRM session. 



 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

Edit 
 

 

 

 

 

 

 

 

The following functions under the            menu are available if the 
logged on user has permissions to perform those actions.  To modify 
user permissions go to                      . 

Add Company 

Only available if user permissions allow.  Opens a blank Company 
entry form. 

Add Contact 

Only available if user permissions allow.  Opens a blank Contact entry 
form. 

Add Opportunity 

Only available if user permissions allow.  Opens a blank Opportunity 
entry form. 

Add Appointment 

Only available if user permissions allow.  Opens a blank Appointment 
entry form. 

Add Task 

Only available if user permissions allow.  Opens a blank Task entry 
form. 

Delete Current Company 

Modal function, meaning it will only delete when in Company mode. 
Only available if user permissions allow.  Use with caution. 

Delete Current Contact 

Modal function, meaning it will only delete when in Contact mode. 
Only available if user permissions allow.  Use with caution. 

 

 

  
 

 



 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

Delete Current Opportunity 

Modal function, meaning it will only delete when in Opportunity 
mode. Only available if user permissions allow.  Use with caution. 

 

 

 

 

Administration 

STD edition 
 
 
 
 
 
 
 
 
 

PRO/CORP editions 
 
 
 
 
 
 
 
 
 

  
 

 
 
 

 
 

 



 

 

� � � � � � � �	 
 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

Report 
 

 

 

Activity Notes 

Selecting this from the pop up menu will change Legrand CRM into 
Calendar mode and display the Activity List search dialogue box. 

Calendar Events 

Selecting this from the pop up menu will change Legrand CRM into 
Calendar mode and display the Calendar Events search dialogue box. 

Tasks 

Selecting this from the pop up menu will change Legrand CRM into 
Calendar mode and display the Task List search dialogue box. 

 

No Transaction report  

The No Transaction report centers on the Contact record and reports 
on those that have had no Activity Notes created in the time period 
selected. 
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 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

Help 
 

 

 

 

 

 

 

 

 

 

FAQ Help 

Opens on-line help. 

Video Clips 

Legrand CRM includes a very useful suite of audio/visual 
presentations for the following: 

o Companies 

o Contacts 

o List Management 

o Marketing Campaigns 

o Sales Opportunities 

o Calendar 

o Outlook Interface 

o Accounting Interface 

o Customer Service 

o Item Tracking 

 

It is highly recommended that you take the time to review each of the 
relevant a/v presentations.  The longest presentation is 4½ minutes. 
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 � �� 
 � � 
 ��� � � �� �� � �� � � � � � � �   � � � � �� � � �

About 

Selecting About will open the following screen.  On this screen is the 
version, serial number and edition of Legrand CRM in use. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Use the 
 � � � � 
 � � � � � � � �  button to install your permanent licence 
codes for the Edition, Plus option and Accounting Link interface. 

 
Figure 76 - Help About screen 
 


